User’s Guide
BASIC
BASIC
This guide provides information concerning installation, basic operation and
troubleshooting on windows.

ADVANCED
This guide provides information about the installation, advanced configuration, operation
and troubleshooting on various OS environments.
Some features may not be available depending on models or countries.

BASIC
1. Introduction
Key benefits

4

Features by models

6

Useful to know

8

About this user’s guide

9

Safety information

10

Machine overview

16

Control panel overview

19

Turning on the machine

21

Installing the driver locally

22

Reinstalling the driver

24

2. Learning the Basic Usage
Media and tray

26

Basic printing

35

Storing the toner cartridge

41

Redistributing toner

43

Replacing the toner cartridge

44

Cleaning the machine

46

Tips for moving & storing your machine

50

4. Troubleshooting
Tips for avoiding paper jams

52

Clearing paper jams

53

Understanding the status LED

56

5. Appendix
Specifications

60

Regulatory information

69

Copyright

79

3. Maintenance
Ordering supplies and accessories

39

Available supplies

40
2

1. Introduction
This chapter provides information you need to know before using the machine.

• Key benefits
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Key benefits
Environmentally friendly

- SL-M2024 series/SL-M2024W series
▪ For single-side printing, 18 ppm (A4) or 19 ppm (Letter).

Convenience

• To save toner and paper, this machine supports the Eco feature (see "Easy
Eco Driver" on page 148).
• To save paper, you can print multiple pages on a single sheet of paper (see
"Using advanced print features" on page 133).
• To save paper, you can print on both sides of the paper (manual doublesided printing) (see "Using advanced print features" on page 133).
• To save electricity, this machine automatically conserves electricity by
substantially reducing power consumption when not in use.
• We recommend using recycled paper for saving energy.

Print with excellent quality and speed

• You can print with a resolution of up to 1,200 x 1,200 dpi effective output.
• Fast, on-demand printing.
- M202x series/M202xW series
▪ For single-side printing, 20 ppm (A4) or 21 ppm (Letter).

• Simply touch your cell phone on the NFC tag on your printer and get the
print job done (see "Using the NFC feature" on page 122).
• Samsung Easy Printer Manager is a program that monitors and informs you
of the machine’s status and allows you to customize the machine’s settings
(see "Using Samsung Easy Printer Manager" on page 151).
• Smart Update allows you to check for the latest software and install the
latest version during the printer driver installation process. This is available
only for Windows OS users.
• If you have Internet access, you can get help, support application, machine
drivers, manuals, and order information from the Samsung website,
www.samsung.com > find your product > Support or Downloads.

Key benefits
Wide range of functionality and application support
Wireless networking may not be available depending on the model
(see "Features by models" on page 6).
• Using the WPS (Wi-Fi Protected Setup™) button

• Supports various paper sizes (see "Print media specifications" on page 62).
• Print watermark: You can customize your documents with words, such as
“Confidential” (see "Using advanced print features" on page 133).
• Print posters: The text and pictures of each page of your document are
magnified and printed across the multiple sheets of paper and can then be
taped together to form a poster (see "Using advanced print features" on
page 133).
• You can print in various operating systems (see "System requirements" on
page 65).
• Your machine is equipped with a USB interface.

Supports various wireless network setting method

- You can easily connect to a wireless network using the WPS button on
the machine and the access point (a wireless router).
• Using the USB cable
- You can connect and set various wireless network settings using a USB
cable.
• Using the Wi-Fi Direct
- You can conveniently print from your mobile device using the Wi-Fi or
Wi-Fi Direct feature.

See "Introducing wireless set up methods" on page 94.

Features by models
Some features and optional goods may not be available depending on model or country.

Operating System
Operating System

M202x series

M202xW series

Windows

●

●

Mac

●

●

Linux

●

●

M202x series

M202xW series

●

●

●

●

Unix

Software
Software
PCL printer driver
SPL printer driver
PS printer driver
XPS printer drivera
Samsung Easy Printer Manager
SyncThru™ Web Service

●

SyncThru™ Web Admin Service

●

Features by models
Software

M202x series

M202xW series

Samsung Printer Status

●

●

Easy Eco Driver Anyweb Print

●

●

Easy Capture Manager

●

●

M202x series

M202xW series

●

●

a. For XPS driver, it is only supported for windows through the Samsung website (www.samsung.com)

Variety feature
Features
Hi-Speed USB 2.0
Network Interface Ethernet 10/100 Base TX wired LAN
Network Interface 802.11b/g/n wireless LAN

●

NFC printing

●

IPv6

●

Eco printing(Easy Eco Driver)a

●

●

Wi-Fi Protected Setup™ (WPS)
Manual duplex (2-sided) printing

●

●

●

AirPrint

●

Google Cloud Print™

●

a. Setting the ECO settings is available from the windows driver.

(●: Included, Blank: Not available)

Useful to know
Where can I download the machine’s driver?

Printouts are blurry.

• Visit www.samsung.com to download the latest machine’s
driver, and install it on your system.

• The toner level might be low or uneven. Shake the toner
cartridge.
• Try a different print resolution setting.

Where can I purchase accessories or supplies?
• Inquire at a Samsung distributor or your retailer.
• Visit www.samsung.com/supplies. Select your country/region
to view product service information.

The status LED flashes or remains constantly on.
• Turn the product off and on again.
• Check the meanings of LED indications in this manual and
troubleshoot accordingly (see "Understanding the status LED"
on page 56).

A paper jam has occurred.
• Open and close the top cover (see "Front view" on page 17).
• Check the instructions on removing jammed paper in this
manual and troubleshoot accordingly (see "Clearing paper
jams" on page 53).

• Replace the toner cartridge.

The machine does not print.
• Open the print queue list and remove the document from the
list (see "Canceling a print job" on page 36).
• Remove the driver and install it again (see "Installing the driver
locally" on page 22).
• Select your machine as your default machine in your Windows.

About this user’s guide
This user's guide provides information for your basic understanding of the
machine as well as detailed steps to explain machine usage.
•

Read the safety information before using the machine.

•

If you have a problem using the machine, refer to the troubleshooting
chapter.

•

Terms used in this user’s guide are explained in the glossary chapter.

•

All illustrations in this user’s guide may differ from your machine depending
on its options or model you purchased.

•

The screenshots in this user's guide may differ from your machine
depending on the machine’s firmware/driver version.

•

The procedures in this user’s guide are mainly based on Windows 7.

2

General icons
Icon

Text

Description

Caution

Gives users information to protect the machine from
possible mechanical damage or malfunction.

Note

Provides additional information or detailed
specification of the machine function and feature.

1

Conventions
Some terms in this guide are used interchangeably, as below:
•

Document is synonymous with original.

•

Paper is synonymous with media, or print media.

•

Machine refers to printer or MFP.
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Safety information
These warnings and precautions are included to prevent injury to you and
others, and to prevent any potential damage to your machine. Be sure to read
and understand all of these instructions before using the machine. After reading
this section, keep it in a safe place for future reference.

4

Operating environment

Warning
3

Important safety symbols
Do not use if the power cord is damaged or if the electrical outlet is
not grounded.

Explanation of all icons and signs used in this chapter

Warning

Hazards or unsafe practices that may result in severe
personal injury or death.

Caution

Hazards or unsafe practices that may result in minor
personal injury or property damage.

Do not attempt.

This could result in electric shock or fire.
Do not place anything on top of the machine (water, small metal or
heavy objects, candles, lit cigarettes, etc.).
This could result in electric shock or fire.
• If the machine gets overheated, it releases smoke, makes
strange noises, or generates an odd odor, immediately turn off
the power switch and unplug the machine.
• The user should be able to access the power outlet in case of
emergencies that might require the user to pull the plug out.
This could result in electric shock or fire.
Do not bend, or place heavy objects on the power cord.
Stepping on or allowing the power cord to be crushed by a heavy
object could result in electric shock or fire.
Do not remove the plug by pulling on the cord; do not handle the
plug with wet hands.
This could result in electric shock or fire.
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Safety information
5

Caution
During an electrical storm or for a period of non-operation,
remove the power plug from the electrical outlet.

Operating method

Caution

This could result in electric shock or fire.
Be careful, the paper output area is hot.

Do not forcefully pull the paper out during printing.

Burns could occur.

It can cause damage to the machine.

If the machine has been dropped, or if the cabinet appears
damaged, unplug the machine from all interface connections and
request assistance from qualified service personnel.

Be careful not to put your hand between the machine and paper
tray.

Otherwise, this could result in electric shock or fire.

You may get injured.

If the machine does not operate properly after these instructions
have been followed, unplug the machine from all interface
connections and request assistance from qualified service
personnel.

This machine's power reception device is the power cord.

Otherwise, this could result in electric shock or fire.

Be care when replacing paper or removing jammed paper.

If the plug does not easily enter the electrical outlet, do not
attempt to force it in.
Call an electrician to change the electrical outlet, or this could
result in electric shock.

To switch off the power supply, remove the power cord from the
electrical outlet.

New paper has sharp edges and can cause painful cuts.
When printing large quantities, the bottom part of the paper
output area may get hot. Do not allow children to touch.
Burns can occur.

Do not allow pets to chew on the AC power, telephone or PC
interface cords.

When removing jammed paper, do not use tweezers or sharp metal
objects.

This could result in electric shock or fire and/or injury to your pet.

It can damage the machine.
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Safety information
Do not allow too many papers to stack up in the paper output tray.

Caution

It can damage the machine.
Do not block or push objects into the ventilation opening.
This could result in elevated component temperatures which can
cause damage or fire.
Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous radiation
exposure.

Before moving the machine, turn the power off and disconnect all
cords. The information below are only suggestions based on the
units weight.If you have a medical condition that prevents you
from lifting, do not lift the machine. Ask for help, and always use
the appropriate amount of people to left the device safety.
Then lift the machine:
• If the machine weighs under 20 kg (44.09 lbs), lift with 1 person.

6

Installation / Moving

Warning
Do not place the machine in an area with dust, humidity, or water
leaks.
This could result in electric shock or fire.
Place the machine in the environment where it meets the
operating temperature and humidity specification.
Otherwise, quality problems can occur and cause damage to the
machine.
See "General specifications" on page 60.

• If the machine weighs 20 kg (44.09 lbs) - 40kg (88.18 lbs), lift
with 2 people.
• If the machine weighs more than 40 kg (88.18 lbs), lift with 4 or
more people.
The machine could fall, causing injury or machine damage.
Choose a flat surface with enough space for ventilation to place
the machine. Also consider the space required to open the cover
and trays.
The place should be well-ventilated and be far from direct light,
heat, and humidity.
When using the machine for a long period of time or printing a
large number of pages in a non-ventilated space, it could pollute
the air and be harmful to your health. Place the machine in a wellventilated space or open a window to circulate the air periodically.
Do not place the machine on an unstable surface.
The machine could fall, causing injury or machine damage.
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Safety information
7

Use only No.26 AWGa or larger, telephone line cord, if necessary.

Maintenance / Checking

Otherwise, it can cause damage to the machine.
Use the power cord supplied with your machine for safe
operation. If you are using a cord which is longer than 2 meters (6
feet) with a 110 V machine, then the gauge should be 16 AWG or
larger.
Otherwise, it can cause damage to the machine, and could result
in electric shock or fire.
Make sure you plug the power cord into a grounded electrical
outlet.
Otherwise, this could result in electric shock or fire.

Caution
Unplug this product from the wall outlet before cleaning the
inside of the machine. Do not clean the machine with benzene,
paint thinner or alcohol; do not spray water directly into the
machine.
This could result in electric shock or fire.

Do not overload wall outlets and extension cords.

When you are working inside the machine replacing supplies or
cleaning the inside, do not operate the machine.

This can diminish performance, and could result in electric shock
or fire.

You could get injured.

Do not put a cover over the machine or place it in an airtight
location, such as a closet.

Keep cleaning supplies away from children.
Children could get hurt.

If the machine is not well-ventilated, this could result in fire.
The machine should be connected tothe power level which is
specified on the label.
If you are unsure and want to check the power level you are using,
contact the electrical utility company.

Do not disassemble, repair or rebuild the machine by yourself.
It can damage the machine. Call a certified technician when the
machine needs repairing.

a. AWG: American Wire Gauge
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Safety information
8

• Do not remove any covers or guards that are fastened with
screws.
• Fuser units should only be repaired by a certified service
technician. Repair by non-certified technicians could result in
fire or electric shock.

Supply usage

Caution

• The machine should only be repaired by a Samsung service
technician.
To clean and operate the machine, strictly follow the user's guide
provided with the machine.

Do not disassemble the toner cartridge.
Toner dust can be dangerous if inhaled or ingested.

Otherwise, you could damage the machine.
Keep the power cable and the contact surface of the plug clean
from dust or water.

Do not burn any of the supplies such as toner cartridge or fuser
unit.

Otherwise, this could result in electric shock or fire.

This could cause an explosion or uncontrollable fire.
When storing supplies such as toner cartridges, keep them away
from children.
Toner dust can be dangerous if inhaled or ingested.
When changing the toner cartridge or removing jammed paper,
be careful not to let toner dust touch your body or clothes.
Toner dust can be dangerous if inhaled or ingested.
When toner gets on your clothing, do not use hot water to wash
it.
Hot water sets toner into fabric. Use cold water.
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Safety information
Using recycled supplies, such as toner, can cause damage to the
machine.
In case of damage due to the use of recycled supplies, a service
fee will be charged.
For supplies that contain toner dust (toner cartridge, waste toner
bottle, imaging unit, etc.) follow the instructions below.
• When disposing of the supplies, follow the instructions for
disposal. Refer to the reseller for disposal instructions.
• Do not wash the supplies.
• For a waste toner bottle, do not reuse it after emptying the
bottle.
If you do not follow the instructions above, it may cause machine
malfunction and environmental pollution. The warranty does not
cover damages caused by a user's carelessness.
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Machine overview
9

Components
The actual component may differ from the illustration below. Some components may change depending on the circumstances.

Power cord

Quick installation guide

Software CDa

Misc. accessoriesb

a. The software CD contains the printer drivers and software applications.
b. Miscellaneous accessories included with your machine may vary by country of purchase and specific model.
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Machine overview
10

Front view
• This illustration may differ from your machine depending on its model.
• Some features and optional goods may not be available depending on model or country (see "Features by models" on page 6).

1
5

6

4
2

7
8

3

1

Output tray

5

NFC (Near Field Communication) tag

2

Control panel

6

Top cover

3

Tray

7

Toner cartridge

4

Output support

8

Paper width guide
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Machine overview
11

Rear view
• This illustration may differ from your machine depending on its model.
• Some features and optional goods may not be available depending on model or country (see "Features by models" on page 6).

1
2
1

USB port

2

Power receptacle
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Control panel overview
This control panel may differ from your machine depending on its model.
There are various types of control panels.

2

Configures the wireless network connection easily
without a computer (see "Wireless network setup" on
page 93).
• Configuration sheet
- Press and hold this button for about 10 seconds
until the green LED blinks slowly, and release.

1
WPSa

• Prints supplies info report / usage count report
- Press and hold this button for about 15 seconds
until the green LED on, and release.

2

• Manual print
- Press this button each time you load a sheet of
paper in the tray if you have selected Manual
Feeder for Source in your printer driver.

3

4

1

Toner
LED

Shows the status of the toner (see "Status LED" on page
57).
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Control panel overview
2

• Prints the screen
- Press this button and the green LED will start
blinking. If you want to print only the active screen,
release the button when the green LED stops
blinking. If you want to print the whole screen,
release the button while it’s blinking.

Print
screenb

3

Power

You can turn the power off or wake the machine up from
the sleep mode with this button.

4

Status
LED

Shows the status of your machine (see "Status LED" on
page 57).

a. M202xW only.
b. M202x only.

• Print Screen can only be used in the Windows
and Mac operating systems.
• You can only use this function with USBconnected machine.
• When printing the active window/whole
monitor screen using the print screen button,
the machine may use more toner depending
on what is being printed.
• You can only use this function if the machine’s
Easy Printer Manager program is installed if
you are a Mac OS user, you need to enable
Screen Print Settings from the Easy Printer
Manager to use the Print Screen feature.
• Configuration sheet
- Press and hold this button for about 10 seconds
until the green LED blinks slowly, and release.
• Prints supplies info report / error report
- Press and hold this button for about 15 seconds
until the green LED on, and release.
• Manual print
- Press this button each time you load a sheet of
paper in the tray if you have selected Manual
Feeder for Source in your printer driver.
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Turning on the machine
1

Connect the machine to the electricity supply first.

1
2

2

Press

(power) on the control panel.

If you want to turn the power off, press

(power) on the control panel.
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Installing the driver locally
A locally connected machine is a machine directly attached to your computer
using the cable.

• If you are a Mac or Linux OS user, refer to the "Software Installation" on
page 83.

12

Windows

1

Insert the supplied software CD into your CD-ROM drive.
If the installation window does not appear, click Start > All programs >
Accessories > Run.

• The installation window in this User’s Guide may differ depending on the
machine and interface in use.

X:\Setup.exe replacing “X” with the letter, which represents your CDROM drive and click OK.

• Only use a USB cable no longer than 3 meters (118 inches).

•

For Windows 8,
If the installation window does not appear, from Charms, select
Search > Apps and search for Run. Type in X:\Setup.exe, replacing
“X” with the letter that represents your CD-ROM drive and click OK.If
“Tap to choose what happens with this disc.” pop-up window
appears, click the window and select Run Setup.exe.

2

Review and accept the installation agreements in the installation
window. Then, click Next.

3

Select USB connection on the Printer Connection Type screen. Then,
click Next.

4

Follow the instructions in the installation window.
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Installing the driver locally
From the Windows 8 Start Screen
• The V4 driver is automatically downloaded from the Windows Update if
your computer is connected to the Internet. If not, you can manually
download the V4 driver from Samsung website, www.samsung.com >
find your product > Support or downloads.
• You can download Samsung Printer Experience app from the Windows
Store. You need have a Microsoft account to use the Windows Store.
1 From Charms, select Search.
2 Click Store.
3 Search and click Samsung Printer Experience.
4 Click Install.
• If you install the driver using the supplied software CD, V4 driver is not
installed. If you want to use the V4 driver in the Desktop screen, you can
download from the Samsung website, www.samsung.com >find your
product > Support or downloads.
• If you want to install Samsung’s printer management tools, you need to
install them using the supplied software CD .

1

Make sure that your computer is connected to the Internet and powered
on.

2
3

Make sure that the machine is powered on.
Connect the computer and the machine with a USB cable.
The driver is automatically installed from the Windows Update.
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Reinstalling the driver
If the printer driver does not work properly, follow the steps below to reinstall
the driver.

13

Windows

1

Make sure that the machine is connected to your computer and
powered on.

2

From the Start menu, select Programs or All Programs > Samsung
Printers > Uninstall Samsung Printer Software.
•

For Windows 8,
1 From Charms, select Search > Apps.
2 Search and click Control Panel.

From the Windows 8 Start Screen

1

Make sure that the machine is connected to your computer and
powered on.

2

Click on the Uninstall Samsung Printer Software tile in the Start
screen.

3

Follow the instructions in the window.

• If you cannot find a Samsung Printer Software tile, unintstall from the
desktop screen mode.
• If you want to uninstall Samsung’s printer management tools, from the
Start screen, right-click the app > Uninstall > right-click the program
you want to delete > Uninstall and follow the instruction in the window.

3 Click Programs and Features.
4 Right-click the driver you want to uninstall and select Uninstall.
5 Follow the instructions in the window.

3
4

Follow the instructions in the installation window.
Insert the software CD into your CD-ROM drive and install the driver
again (see "Installing the driver locally" on page 22).
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2. Learning the Basic Usage
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would
like to set or change values.

• Media and tray

26

• Basic printing

35

Media and tray
This chapter provides information on how to load print media into your
machine.

• Using print media that does not meet these specifications may cause
problems or require repairs. Such repairs are not covered by Samsung’s
warranty or service agreements.
• Make sure not to use the inkjet photo paper with this machine. It could
cause damage to the machine.

2

• Using inflammable print media can cause a fire.
• Use designated print media (see "Print media specifications" on page 62).

1
The use of inflammable media or foreign materials left in the printer may
lead to overheating of the unit and, in rare cases may cause a fire.

1 Paper width guide
2 Tray

If you do not adjust the guide, it may cause paper registration, image skew,
or jamming of the paper.

1

Tray overview
To change the size, you need to adjust the paper guide.
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Media and tray
2

Loading paper in the tray

1

3

Adjust the tray size to the media size you are loading (see "Tray overview"
on page 26). Then place the paper with the side you want to print facing
up and open the output tray.

Open the tray.

3
1
4
2

4
2

Squeeze the paper width guide and slide it to the edge of the paper stack
without causing it to bend.

Flex or fan the edge of the paper stack to separate the pages before
loading papers.
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Media and tray
• Do not push the paper width guide too far causing the media to warp.
• If you do not adjust the paper width guide, it may cause paper jams.

• Do not use a paper with a leading-edge curl, it may cause a paper jam or
the paper can be wrinkled.

5

When you print a document, set the paper type and size for the tray (see
"Setting the paper size and type" on page 34).

2. Learning the Basic Usage
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Media and tray
• When the machine is in a power save mode, the machine does not feed
paper from the manual feeder. Wake up the machine by pressing the
power button before using the manual feeder.

3

Manual feeding in the tray
The manual feeder can hold special sizes and types of print material, such as
postcards, note cards, and envelopes (see "Print media specifications" on page
62).

Tips on using the manual feeder
• Load only one type, size and weight of print media at time in the manual
feeder.
• If you select Paper > Source > Manual Feeder for the paper source in
your software application, you need to press

(Print screen) or

(WPS) button each time you print a page and load only one type,
size and weight of print media at a time on the manual tray.
• To prevent paper jams, do not add paper while printing when there is still
paper in the manual feeder.
• Print media should be loaded face up with the top edge going into the
manual feeder first and be placed in the center of the tray.
• To ensure printing quality and to prevent paper jams, only load the
available paper (see "Print media specifications" on page 62).
• Flatten any curl on postcards, envelopes, and labels before loading them
into the manual feeder.
• When printing on special media, you must follow the loading guidelines
(see "Printing on special media" on page 30).
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Media and tray
4

Types

Printing on special media

Traya

Envelope

●

The table below shows the special media usable in tray.

Preprinted

●

To change the paper setting set in the machine, from the Printing preferences
window > Paper tab > Paper Type (see "Opening printing preferences" on page
36).

Cotton

●

Recycled

●

Archive

●

When using special media, we recommend you feed one sheet at a time (see
"Print media specifications" on page 62).

a. The paper types available manual feeding in tray.

(●: Supported)
To see for paper weights for each sheet, refer to "Print media specifications" on
page 62.

Types

Traya

Plain

●

Thick

●

Thin

●

Bond

●

Color

●

CardStock

●

Labels

●

2. Learning the Basic Usage
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Media and tray
Envelope

•

Do not use stamped envelopes.

•

Do not use envelopes with clasps, snaps, windows, coated lining, selfadhesive seals, or other synthetic materials.

•

Do not use damaged or poorly made envelopes.

•

Be sure the seam at both ends of the envelope extends all the way to the
corner of the envelope.

Printing successfully on envelopes depends upon the quality of the envelopes.
To print an envelope, place it as shown in the following figure.

2

1

1 Acceptable
2 Unacceptable

•

Envelopes with a peel-off adhesive strip or with more than one flap that
folds over to seal must use adhesives compatible with the machine’s fusing
temperature for 0.1 second (about 170°C (338 °F)). The extra flaps and strips
might cause wrinkling, creasing, or jams, and may even damage the fuser.

•

For the best print quality, position margins no closer than 15 mm from the
edges of the envelope.

•

Avoid printing over the area where the envelope’s seams meet.

If you select Envelope from the Printing Preferences window, but the printed
images get easily erased, select Thick Envelope and try printing again.
However, this might cause some noise when printing.
•

•

When selecting envelopes, consider the following factors:
-

Weight: should not exceed 90 g/m2 otherwise; jams may occur.

-

Construction: should lie flat with less than 6 mm curl and should not
contain air.

-

Condition: should not be wrinkled, nicked, nor damaged.

-

Temperature: should resist the heat and pressure of the machine
during operation.

Use only well-constructed envelopes with sharp and well-creased folds.
2. Learning the Basic Usage
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Media and tray
Labels

•

Make sure that there is no exposed adhesive material between labels.
Exposed areas can cause labels to peel off during printing, which can cause
paper jams. Exposed adhesive can also cause damage to machine
components.

•

Do not run a sheet of labels through the machine more than once. The
adhesive backing is designed for only a single pass through the machine.

•

Do not use labels that are separating from the backing sheet or are wrinkled,
bubbled, or otherwise damaged.

To avoid damaging the machine, use only labels designed for use in laser
printers.

Card stock/ Custom-sized paper

•

When selecting labels, consider the following factors:
-

Adhesives: Should be stable at your machine’s fusing temperature.
Check your machine’s specifications to view the fusing temperature
(about 170°C (338°F)).

-

Arrangement: Only use labels with no exposed backing between them.
Labels can peel off sheets that have spaces between the labels, causing
serious jams.

-

Curl: Must lie flat with no more than 13 mm of curl in any direction.

-

Condition: Do not use labels with wrinkles, bubbles, or other
indications of separation.

•

In the software application, set margins at least 6.4 mm (0.25 inches) away
from the edges of the material.
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Media and tray
Preprinted paper
When loading preprinted paper, the printed side should be facing up with an
uncurled edge at the front. If you experience problems with paper feeding, turn
the paper around. Note that print quality is not guaranteed.

•

Must be printed with heat-resistant ink that will not melt, vaporize, or
release hazardous emissions when subjected to the machine’s fusing
temperature for 0.1 second (about 170°C (338°F)).

•

Preprinted paper ink must be non-flammable and should not adversely
affect machine rollers.

•

Before you load preprinted paper, verify that the ink on the paper is dry.
During the fusing process, wet ink can come off preprinted paper, reducing
print quality.
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Media and tray
5

Setting the paper size and type
After loading paper in the paper tray, set the paper size and type.
To change the paper setting set in the machine, from the Printing preferences
window > Paper tab > Paper Type (see "Opening printing preferences" on page
36).

If you want to use special-sized paper such as billing paper, select Custom
in the Paper tab in the Printing Preferences (see "Opening printing
preferences" on page 36).
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Basic printing
For special printing features, refer to the Advanced Guide (see "Using
advanced print features" on page 133).

3

Select your machine from the Select Printer list.

4

The basic print settings including the number of copies and print range
are selected within the Print window.

6

Printing

If you are a Mac or Linux user, refer to the "Mac printing" on page 140 or
"Linux printing" on page 142.

The following Printing Preferences window is for Notepad in Windows 7.

1
2

Open the document you want to print.
Select Print from the File menu.

To take advantage of the advanced printing features, click Properties or
Preferences from the Print window (see "Opening printing preferences" on
page 36).

5

To start the print job, click OK or Print in the Print window.
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Basic printing
7

Canceling a print job

4

Click Properties or Preferences.

If the print job is waiting in the print queue or print spooler, cancel the job as
follows:
•

You can access this window by simply double-clicking the machine icon
(

) in the Windows task bar.

8

Opening printing preferences
• The Printing Preferences window that appears in this user’s guide may
differ depending on the machine in use. However, the composition of
the Printing Preferences window is similar.
• When you select an option in Printing Preferences, you may see a
warning mark
or
. An
mark means you can select that certain
option but it is not recommended, and an
mark means you cannot
select that option due to the machine’s setting or environment.

1
2
3

You can check the machine's current status using the Printer Status button
(see "Using Samsung Printer Status" on page 154).

Open the document you want to print.
Select Print from the file menu.
Select your machine from the Select Printer.
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Basic printing
Using a favorite setting
To use a saved setting, select it in the Favorites tab. The machine is now set
to print according to the settings you have selected.

The Favorites option, which is visible on each preferences tab except for the
Samsung tab, allows you to save the current preferences for future use.

To delete saved settings, select it in the Favorites tab and click Delete.

To save a Favorites item, follow these steps:

1
2

Change the settings as needed on each tab.

9

Using help
Enter a name for the item in the Favorites input box.
Click the option you want to know on the Printing Preferences window and
press F1 on your keyboard.

10

Eco printing
The Eco function cuts toner consumption and paper usage. The Eco function
allows you to save print resources and lead you to eco-friendly printing.

3
4
5

Click Save.
Enter name and description, and then select the desired icon.

To Eco Printing, click the below:
See "Easy Eco Driver" on page 148.

Click OK. When you save Favorites, all current driver settings are saved.
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3. Maintenance
This chapter provides information about purchasing supplies, accessories and maintenance parts available for your
machine.

• Ordering supplies and accessories

39

• Available supplies

40

• Storing the toner cartridge

41

• Redistributing toner

43

• Replacing the toner cartridge

44

• Cleaning the machine

46

• Tips for moving & storing your machine

50

Ordering supplies and accessories
Available accessories may differ from country to country. Contact your sales representatives to obtain the list of available supplies, and maintenance parts.

To order Samsung-authorized supplies, accessories, and maintenance parts, contact your local Samsung dealer or the retailer where you purchased your machine.
You can also visit www.samsung.com/supplies, and then select your country/region to obtain the contact information for service.
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Available supplies
When supplies reach the end of their life spans, you can order the following types of supplies for your machine:
Average yielda

Type
Toner cartridge

Approx. 1,000 pages

Part name
MLT-D111S

a. Declared yield value in accordance with ISO/IEC 19752.

Depending on the options, percentage of image area, and job mode used, the toner cartridge’s lifespan may differ.

When purchasing new toner cartridges or other supplies, these must be purchased in the same country as the machine you are using. Otherwise, new toner
cartridges or other supplies will be incompatible with your machine due to different configurations of toner cartridges and other supplies according to the specific
country conditions.

Samsung does not recommend using non-genuine Samsung toner cartridge such as refilled or remanufactured toner. Samsung cannot guarantee non-genuine
Samsung toner cartridge's quality. Service or repair required as a result of using non-genuine Samsung toner cartridges will not be covered under the machine’s
warranty.
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Storing the toner cartridge
Toner cartridges contain components that are sensitive to light, temperature and humidity. Samsung suggests users follow these recommendations to ensure
optimal performance, highest quality, and longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment in which the printer will be used. This should be in controlled temperature and humidity conditions. The toner cartridge
should remain in its original and unopened package until installation – if original packaging is not available, cover the top opening of the cartridge with paper and
store in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful shelf and operating life. Do not store on the floor. If the toner cartridge is removed from
the printer, follow the instructions below to store the toner cartridge properly.
•

Store the cartridge inside the protective bag from the original package.

•

Store lying flat (not standing on end) with the same side facing up as if it were installed in the machine.

•

Do not store consumables in any of the following conditions:
-

Temperature greater than 40°C (104°F).

-

Humidity range less than 20% and greater than 80%.

-

An environment with extreme changes in humidity or temperature.

-

Direct sunlight or room light.

-

Dusty places.

-

A car for a long period of time.

-

An environment where corrosive gases are present.

-

An environment with salty air.
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Storing the toner cartridge
1

3

Handling instructions
•

Do not touch the surface of the photoconductive drum in the cartridge.

•

Do not expose the cartridge to unnecessary vibrations or shock.

•

Never manually rotate the drum, especially in the reverse direction; this can
cause internal damage and toner spillage.

Estimated cartridge life
Estimated cartridge life the life of the toner cartridge (or imaging unit) yield
depends on the amount of toner that print jobs require. The actual print yield
may vary depending on the print density of the pages you print on, operating
environment, percentage of image area, printing interval, media type and/or
media size. For example, if you print a lot of graphics, the consumption of the
toner is higher and you may need to change the cartridge more often.

2

Toner cartridge usage
Samsung Electronics does not recommend or approve the use of non-Samsung
brand toner cartridges in your printer including generic, store brand, refilled, or
remanufactured toner cartridges.

Samsung’s printer warranty does not cover damage to the machine caused
by the use of a refilled, remanufactured, or non-Samsung brand toner
cartridges.

3. Maintenance

42

Redistributing toner
When the toner cartridge is near the end of its life:
•

White streaks or light printing occurs and/or density variation side to side.

•

The Toner LED blinks orange.

If this happens, you can temporarily improve print quality by redistributing the remaining toner in the cartridge. In some cases, white streaks or light printing will still
occur even after you have redistributed the toner.

• Before opening the top cover, close the output support first.
• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.

2

1

3
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Replacing the toner cartridge
4

Toner cartridge

Click this link to open an animation about replacing a toner cartridge.

• Before opening the top cover, close the output support first.
• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.
• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.
• Shake the toner cartridge thoroughly, it will increase the initial print quality.
• Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.
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Replacing the toner cartridge
When a toner cartridge has reached the end of life, the machine will stop printing.

2

1

3. Maintenance

45

Cleaning the machine
If printing quality problems occur or if you use your machine in a dusty environment, you need to clean your machine regularly to keep it in the best printing
condition and use your machine longer.

• Cleaning the cabinet of the machine with cleaning materials containing large amounts of alcohol, solvents, or other strong substances can discolor or distort the
cabinet.
• If your machine or the surrounding area is contaminated with toner, we recommend you use a cloth or tissue dampened with water to clean it. If you use a vacuum
cleaner, toner blows in the air and might be harmful to you.
• During the printing process, paper, toner, and dust particles can accumulate inside the machine. This buildup can cause print quality problems, such as toner
specks or smearing. Cleaning the inside of the machine clears and reduces these problems.

5

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth slightly with water, but be careful not to let any water drip onto or into the machine.
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Cleaning the machine
6

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate inside the machine. This buildup can cause print quality problems, such as toner specks
or smearing. Cleaning the inside of the machine clears and reduces these problems.

• Use a dry lint-free cloth to clean the machine.
• If your machine has a power switch, turn the power switch off before cleaning the machine.
• Before opening the top cover, close the output support first.
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Cleaning the machine
2

1

2

3

1

1
2
2
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Cleaning the machine
7

Cleaning the pickup roller
• Use a dry lint-free cloth to clean the machine.
• If your machine has a power switch, turn the power switch off before cleaning the machine.

2

12
1

2
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Tips for moving & storing your machine
•

When moving the machine, do not tilt or turn it upside down. Otherwise, the inside of the machine may be contaminated by toner, which can cause damage to
the machine or reduce print quality.

•

When moving the machine, make sure at least two people are holding the machine securely.
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4. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Tips for avoiding paper jams

52

• Clearing paper jams

53

• Understanding the status LED

56

This chapter gives helpful information for what to do if you encounter an error.If your machine
has a display screen, check the message on the display screen first to solve the error. If you
cannot find a solution to your problem in this chapter, refer to the Troubleshooting chapter in
the Advanced User's Guide (see "Troubleshooting" on page 162).If you cannot find a solution in
the User's Guide or the problem persists, call for service.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. To avoid paper jams, refer to the following guidelines:
•

Ensure that the adjustable guides are positioned correctly (see "Tray overview" on page 26).

•

Do not overload the tray. Ensure that the paper level is below the paper capacity mark on the inside of the tray.

•

Do not remove paper from the tray while your machine is printing.

•

Flex, fan, and straighten paper before loading.

•

Do not use creased, damp, or highly curled paper.

•

Do not mix paper types in a tray.

•

Use only recommended print media (see "Print media specifications" on page 62).
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Clearing paper jams
To avoid tearing the paper, pull the jammed paper out slowly and gently.

1

In tray

Click this link to open an animation about clearing a jam.

1

2

2

1

3
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Clearing paper jams
2

Inside the machine

Click this link to open an animation about clearing a jam.

• The fuser area is hot. Take care when removing paper from the machine.
• Before opening the top cover, close the output support first.

1

2
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Clearing paper jams
If you do not see the paper in this area, stop and go to next step:

2

1

2

1
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Understanding the status LED
The color of the LED indicates the machine's current status.

• Some LEDs may not be available depending on model or country.
• To resolve the error, look at the error message and its instructions from the troubleshooting part.
• You can also resolve the error with the guidelines from the Samsung Printer Status window or Smart Panel program window.
• If the problem persists, call a service representative.

4. Troubleshooting

56

Understanding the status LED
3

Status LED
Status

Description

Off

The machine is off-line or save mode.
Blinking

Green

• When the backlight blinks rapidly, the machine is printing data.

On

The machine is on-line and can be used.

Blinking

Waiting for a

(Status
LED)

• When the machine is receiving data and printing data.

(Print screen) or

(WPS) button to be pressed for manual printing.

• The cover is opened. Close the cover.
Red
On

• There is no paper in the tray when receiving or printing data. Load paper in the tray ("Loading paper in the tray" on
page 27).
• The machine has stopped due to a major error.
• When the machine is manual and manual duplex printing.

Blinking

Upgrading firmware.

On

A paper jam has occurred (see "Clearing paper jams" on page 53).

Orange
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Understanding the status LED
4

Toner LED/ WPS LED/ Power LED
Status

(Toner LED)

(WPS LED)b

(Power LED)

Description

Blinking

Small amount of toner is left in the cartridge. The estimated cartridge life of toner is close. Prepare a new cartridge for
replacement. You may temporarily increase the printing quality by redistributing the toner (see "Redistributing toner"
on page 43).

On

A toner cartridge has almost reached its estimated cartridge lifea. It is recommended to replace the toner cartridge (see
"Replacing the toner cartridge" on page 44).

Off

All toner cartridges are at normal capacity.

Blinking

The machine is connecting to a wireless network.

On

The machine is connected to a wireless network (see "Using the WPS button" on page 96).

Off

The machine is disconnected from a wireless network.

On

The machine is in power save mode.

Off

The machine is in ready mode or the machine’s power is off.

Orange

Blue

Blue

a. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/IEC 19752. The number of pages
may be affected by operating environment, printing interval, graphics, media type and media size. Some amount of toner may remain in the cartridge even when red LED is on and the printer
stops printing.
b. Wireless model only (see "Features by models" on page 6).
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Specifications
1

General specifications

The specification values listed below are subject to change without notice. See www.samsung.com for possible changes in information.

Items

Description

Dimension

Width x Length x Height

331 x 215 x 178 mm (13.03 x 8.46 x 7.01 inches)

Weight

Machine with consumables

3.97 kg (8.75 lbs)

Ready mode

Less than 26 dB (A)

Print mode

Less than 50 dB (A)

Operation

10 to 30 °C (50 to 86 °F)

Storage (packed)

-20 to 40 °C (-4 to 104 °F)

Operation

20 to 80% RH

Storage (packed)

10 to 90% RH

110 volt models

AC 110 - 127 V

220 volt models

AC 220 - 240 V

Noise Levela
Temperature

Humidity

Power ratingb
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Specifications
Items

Power consumption

Description

Average operating mode

Less than 310 W

Ready mode

Less than 30 W
• M202x series: Less than 1.1 W

Power save modec

• M202xW series: Less than 1.9 W ( Wi-Fi Direct off :Less than 1.5 W )
• M2020W/M2021W/M2024W: Less than 1.5 W

Wireless f

Power off moded

Less than 0.45 W (0.1 We)

Module

SPW-B4319S

a. Sound Pressure Level, ISO 7779. Configuration tested: basic machine installation, A4 paper, simplex printing. China only: If the equipment's noise is louder than 63 db (A), the equipment should
be placed in region of relatively independent advice.
b. See the rating label on the machine for the correct voltage (V), frequency (hertz) and type of current (A) for your machine.
c. The power consumption of power save mode may be affected by machine's status, setting conditions, operating environment.
d. Power consumption can be completely avoided only when the power cable is not connected.
e. For the machine that has a power switch.
f. Wireless model only (see "Features by models" on page 6).
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2

Print media specifications
Print media weight/Capacitya
Type

Size

Dimensions
Tray

Plain

Manual feeding in trayb

Letter

216 x 279 mm (8.5 x 11 inches)

71 to 85 g/m2 (19 to 23 lbs bond)

71 to 85 g/m2 (19 to 23 lbs bond)

Legal

216 x 356 mm (8.5 x 14 inches)

• 1 sheet

Folio

216 x 330 mm (8.5 x 13 inches)

• 150 sheets of 80 g/m2 (21 lbs
bond)

A4

210 x 297 mm (8.27 x 11.69 inches)

Oficio

216 x 343 mm (8.5 x 13.5 inches)

B5(JIS)

182 x 257 mm (7.17 x 10.12 inches)

B5(ISO)

176 x 250 mm (6.93 x 9.84 inches)

Executive

184 x 267 mm (7.25 x 10.5 inches)

A5

148 x 210 mm (5.83 x 8.27 inches)

Monarch Envelope

98 x 191 mm (3.87 x 7.5 inches)

75 to 90 g/m2 (20 to 24 lbs bond) 75 to 90 g/m2 (20 to 24 lbs bond)

No 10 Envelope

105 x 241 mm (4.12 x 9.5 inches)

• 10 sheets

DL Envelope

110 x 220 mm (4.33 x 8.66 inches)

C5 Envelope

162 x 229 mm (6.38 x 9.02 inches)

• 1 sheet

Envelope
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Print media weight/Capacitya
Type

Size

Dimensions
Manual feeding in trayb

Tray
Refer to the Plain section
Thick

Refer to the Plain
section

Color

Refer to the Plain
section

Refer to the Plain
section

Recycled

Refer to the Plain
section

• 1 sheet

75 to 90 g/m2 (20 to 24 lbs bond) 75 to 90 g/m2 (20 to 24 lbs bond)
• 150 sheets of 80 g/m2 (21 lbs
bond)

Refer to the Plain section

• 1 sheet

75 to 90 g/m2 (20 to 24 lbs bond) 75 to 90 g/m2 (20 to 24 lbs bond)
• 150 sheets of 80 g/m2 (21 lbs
bond)

Refer to the Plain section

• 1 sheet

75 to 90 g/m2 (20 to 24 lbs bond) 75 to 90 g/m2 (20 to 24 lbs bond)
• 150 sheets of 80 g/m2 (21 lbs
bond)

Refer to the Plain section

Preprinted

60 to 70 g/m2 (16 to 19 lbs bond) 60 to 70 g/m2 (16 to 19 lbs bond)
• 160 sheets of 60 g/m2 (16 lbs
bond)

Refer to the Plain section
Refer to the Plain
section

• 1 sheet

• 50 sheets of 120 g/m (32 lbs
bond)

Refer to the Plain
section

Cotton

86 to 120 g/m2 (23 to 32 lbs bond)

2

Refer to the Plain section
Thin

86 to 120 g/m2 (23 to 32 lbs
bond)

• 1 sheet

60 to 90 g/m2 (16 to 24 lbs bond) 60 to 90 g/m2 (16 to 24 lbs bond)
• 150 sheets of 80 g/m2 (21 lbs
bond)

• 1 sheet
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Print media weight/Capacitya
Type

Size

Dimensions
Tray

Labelsc

CardStock

Letter, Legal, Oficio,
Folio, A4, B5(JIS),
B5(ISO), Executive,
A5

Refer to the Plain section

Letter, Legal, Oficio,
Folio, A4, B5(JIS),
B5(ISO), Executive,
A5,

Refer to the Plain section

120 to 150 g/m2 (32 to 40 lbs
bond)

Manual feeding in trayb
120 to 150 g/m2 (32 to 40 lbs bond)
• 1 sheet

• 10 sheets
121 to 163 g/m2 (32 to 43 lbs
bond)

121 to 163 g/m2 (32 to 43 lbs bond)
• 1 sheet

• 10 sheets

Postcard 4x6
Bond

Refer to the Plain
section

Refer to the Plain section

• 10 sheets

• 1 sheet

Archive

Refer to the Plain
section

Refer to the Plain section

• 100 sheets

• 1 sheet

Minimum size (custom)

76 x 127 mm (3 x 5 inches)

60 to 163 g/m2 (16 to 43 lbs bond)

Maximum size (custom)

216 x 356 mm (8.5 x 14 inches)

a. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.
b. Feed one sheet at a time.
c. The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness.
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System requirements

Microsoft® Windows®
Requirement (recommended)
Operating system
CPU

RAM

free HDD space

Windows® XP

Intel® Pentium® III 933 MHz (Pentium IV 1 GHz)

128 MB (256 MB)

1.5 GB

Windows Server® 2003

Intel® Pentium® III 933 MHz (Pentium IV 1 GHz)

128 MB (512 MB)

1.25 GB to 2 GB

Windows Server® 2008

Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz)

512 MB (2 GB)

10 GB

Windows Vista®

Intel® Pentium® IV 3 GHz

512 MB (1 GB)

15 GB

Windows® 7

Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher

1 GB (2 GB)

16 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).
• DVD-R/W Drive
Windows Server® 2008 R2

Intel® Pentium® IV 1.4 GHz (x64) or 1.4 GHz (x64) processors (2 GHz or faster)

512 MB (2 GB)

10 GB

Windows® 8

Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher

2 GB

20 GB

Windows® 8.1

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).

512 MB (2 GB)

32 GB

• DVD-R/W Drive
Windows Server® 2012

Intel® Pentium® IV 1.4 GHz (x64) or 1.4 GHz (x64) processors (2 GHz or faster)

Windows Server® 2012 R2

5. Appendix

65

Specifications
• Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating systems.
• Users who have administrator rights can install the software.
• Windows Terminal Services is compatible with your machine.

Mac
Requirements (Recommended)
Operating system
CPU
Mac OS X 10.5

• Intel® processors

RAM

Free HDD space

512 MB (1 GB)

1 GB

• 867 MHz or faster Power PC G4/ G5

Mac OS X 10.6

• Intel® processors

1 GB (2 GB)

1 GB

Mac OS X 10.7 ~ 10.9

• Intel® processors

2 GB

4 GB
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Linux
Items

Requirements
Red Hat Enterprise Linux 5, 6
Fedora 11, 12, 13, 14, 15, 16, 17, 18
openSUSE 11.0, 11.1, 11.2, 11.3, 11.4, 12.1, 12.2, 12.3

Operating system

Ubuntu 10.04, 10.10, 11.04, 11.10, 12.04, 12.10
SUSE Linux Enterprise Desktop 10, 11
Debian 5.0, 6.0
Mint 13, 14

CPU

Pentium IV 2.4GHz (Intel Core™2)

RAM

512 MB (1 GB)

Free HDD space

1 GB (2 GB)
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4

Network environment

Wireless models only (see "Features by models" on page 6).

You need to set up the network protocols on the machine to use it as your network machine. The following table shows the network environments supported by the
machine.
Items
Network interface

Specifications
• 802.11b/g/n Wireless LAN ( M202xW only)
• Windows Server 2003 /Server 2008/XP/Vista/7/8/Server 2008 R2

Network operating system

• Various Linux OS
• Mac OS X 10.5 ~ 10.9
• TCP/IPv4
• DHCP, BOOTP

Network protocols

• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing (RAW), LPR, IPP, WSD
• SNMPv 1/2/3, HTTP, IPSec
• TCP/IPv6 (DHCP, DNS, RAW, LPR, SNMPv 1/2/3, HTTP, IPSec)

Wireless security

• Authentication: Open System, Shared Key, WPA Personal, WPA2 Personal (PSK)
• Encryption: WEP64, WEP128, TKIP, AES
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Regulatory information
This machine is designed for a normal work environment and certified with
several regulatory statements.

When using this product, these basic safety precautions should always be
followed to reduce risk of fire, electric shock, and injury to persons:

5

Laser safety statement
The printer is certified in the U.S. to conform to the requirements of DHHS 21
CFR, chapter 1 Subchapter J for Class I(1) laser products, and elsewhere is
certified as a Class I laser product conforming to the requirements of IEC 608251 :2007.
Class I laser products are not considered to be hazardous. The laser system and
printer are designed so there is never any human access to laser radiation above
a Class I level during normal operation, user maintenance or prescribed service
condition.
6

Warning
Never operate or service the printer with the protective cover removed from
laser/scanner assembly. The reflected beam, although invisible, can damage
your eyes.

Ozone safety
This product's ozone emission rate is under 0.1 ppm. Because
ozone is heavier than air, keep the product in a place with good
ventilation.
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7

9

Power saver

China only

This printer contains advanced energy conservation technology
that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of
time, power consumption is automatically lowered.
ENERGY STAR and the ENERGY STAR mark are registered U.S.
marks.
For more information on the ENERGY STAR program see http://
www.energystar.gov
For ENERGY STAR certified models, the ENERGY STAR label will be
on your machine. Check if your machine is ENERGY STAR
certified.

Website : http://www.samsung.com/cn/support/location/
supportServiceLocation.do?page=SERVICE.LOCATION
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Recycling
Recycle or dispose of the packaging material for this product in an
environmentally responsible manner.
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Regulatory information
The United States of America only

10

Correct disposal of this product (Waste electrical &
electronic equipment)

(Applicable in countries with separate collection
systems)

Dispose unwanted electronics through an approved recycler. To find the nearest
recycling location, go to our website:www.samsung.com/recyclingdirect Or call,
(877) 278 - 0799

11

State of California Proposition 65 Warning (US Only)
This marking on the product, accessories or literature indicates that the
product and its electronic accessories (e.g. charger, headset, USB cable)
should not be disposed of with other household waste at the end of
their working life. To prevent possible harm to the environment or
human health from uncontrolled waste disposal, please separate these
items from other types of waste and recycle them responsibly to
promote the sustainable reuse of material resources.
Household users should contact either the retailer where they
purchased this product, or their local government office, for details of
where and how they can take these items for environmentally safe
recycling.
Business users should contact their supplier and check the terms and
conditions of the purchase contract. This product and its electronic
accessories should not be mixed with other commercial wastes for
disposal.

12

Radio frequency emissions

FCC information to the user
This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:
•

This device may not cause harmful interference, and

•

This device must accept any interference received, including interference
that may cause undesired operation.
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This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:
•

Reorient or relocate the receiving antenna.

•

Increase the separation between the equipment and receiver.

•

Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

•

Consult the dealer or experienced radio TV technician for help.

Change or modifications not expressly approved by the manufacturer
responsible for compliance could void the user's authority to operate the
equipment.

Canadian radio interference regulations
This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and
Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques
applicables aux appareils numériques de Classe B prescrites dans la norme sur le
matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et
Sciences Canada.

13

United states of america

Federal communications commission (FCC)
Intentional emitter per FCC Part 15
Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz Band, may be present
(embedded) in your printer system. This section is only applicable if these
devices are present. Refer to the system label to verify the presence of wireless
devices.
Wireless devices that may be in your system are only qualified for use in the
United States of America if an FCC ID number is on the system label.
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The FCC has set a general guideline of 20 cm (8 inches) separation between the
device and the body, for use of a wireless device near the body (this does not
include extremities). This device should be used more than 20 cm (8 inches)
from the body when wireless devices are on. The power output of the wireless
device (or devices), which may be embedded in your printer, is well below the
RF exposure limits as set by the FCC.

FCC statement for wireless LAN use:
While installing and operating this transmitter and antenna combination
the radio frequency exposure limit of 1m W/cm2 may be exceeded at
distances close to the antenna installed. Therefore, the user must maintain
a minimum distance of 20cm from the antenna at all times. This device
cannot be colocated with another transmitter and transmitting antenna.

This transmitter must not be collocated or operation in conjunction with any
other antenna or transmitter.
Operation of this device is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired
operation of the device.

14

Russia/Kazakhstan/Belarus only

Wireless devices are not user serviceable. Do not modify them in any way.
Modification to a wireless device will void the authorization to use it.
Contact manufacturer for service.
15

Germany only
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Turkey only

The 13 amp plug is the most widely used type in the UK and should be suitable.
However, some buildings (mainly old ones) do not have normal 13 amp plug
sockets. You need to buy a suitable plug adaptor. Do not remove the moulded
plug.

If you cut off the moulded plug, get rid of it straight away.You cannot rewire
the plug and you may receive an electric shock if you plug it into a socket.

17

Thai only

Important warning:
You must earth this machine.
The wires in the mains lead have the following color code:

18

Replacing the fitted plug (for UK only)

• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug
and has a 13 amp fuse. When you change or examine the fuse, you must re-fit
the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost
the fuse cover, do not use the plug until you have another fuse cover.
Contact the people from you purchased the machine.

If the wires in the mains lead do not match the colors marked in your plug, do
the following:
You must connect the green and yellow wire to the pin marked by the letter “E”
or by the safety ‘Earth symbol’ or colored green and yellow or green.
You must connect the blue wire to the pin which is marked with the letter “N” or
colored black.
You must connect the brown wire to the pin which is marked with the letter “L”
or colored red.
5. Appendix
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You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

19

Declaration of conformity (European countries)

Approvals and Certifications
• Hereby, Samsung Electronics, declares that this [M202x series] is
in compliance with the essential requirements and other relevant
provisions of Low Voltage Directive (2006/95/EC), EMC Directive
(2004/108/EC).
• Hereby, Samsung Electronics, declares that this [M202xW series]
is in compliance with the essential requirements and other
relevant provisions of R&TTE Directive 1999/5/EC.
The declaration of conformity may be consulted at
www.samsung.com, go to Support > Download center and enter
your printer (MFP) name to browse the EuDoC.

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of
the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC, approximation of the laws of
the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and
telecommunications terminal equipment and the mutual recognition of their
conformity. A full declaration, defining the relevant Directives and referenced
standards can be obtained from your Samsung Electronics Co., Ltd.
representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal
Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European
single terminal connection to the analogue public switched telephone network
(PSTN) in accordance with Directive 1999/5/EC. The product has been designed
to work with the national PSTNs and compatible PBXs of the European
countries:
In the event of problems, you should contact the Euro QA Lab of Samsung
Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application
of terminal equipment which complies with this standard, the European
Telecommunication Standards Institute (ETSI) has issued an advisory document
(EG 201 121) which contains notes and additional requirements to ensure
network compatibility of TBR21 terminals. The product has been designed
against, and is fully compliant with, all of the relevant advisory notes contained
in this document.
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European radio approval information (for products
fitted with EU-approved radio devices)
Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz band, may be present
(embedded) in your printer system which is intended for home or office use. This
section is only applicable if these devices are present. Refer to the system label
to verify the presence of wireless devices.
Wireless devices that may be in your system are only qualified for
use in the European Union or associated areas if a CE mark is on the
system label.

The power output of the wireless device or devices that may be embedded in
you printer is well below the RF exposure limits as set by the European
Commission through the R&TTE directive.

European states qualified under wireless approvals:
EU countries

European states with restrictions on use:
EU
EEA/EFTA countries

20

Regulatory compliance statements

Wireless guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz Band, may be present
(embedded) in your printer system. The following section is a general overview
of considerations while operating a wireless device.
Additional limitations, cautions, and concerns for specific countries are listed in
the specific country sections (or country group sections). The wireless devices in
your system are only qualified for use in the countries identified by the Radio
Approval Marks on the system rating label. If the country you will be using the
wireless device in, is not listed, contact your local Radio Approval agency for
requirements. Wireless devices are closely regulated and use may not be
allowed.
The power output of the wireless device or devices that may be embedded in
your printer is well below the RF exposure limits as known at this time. Because
the wireless devices (which may be embedded into your printer) emit less
energy than is allowed in radio frequency safety standards and
recommendations, manufacturer believes these devices are safe for use.
Regardless of the power levels, care should be taken to minimize human contact
during normal operation.

No limitations at this time
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As a general guideline, a separation of 20 cm (8 inches) between the wireless
device and the body, for use of a wireless device near the body (this does not
include extremities) is typical. This device should be used more than 20 cm (8
inches) from the body when wireless devices are on and transmitting.

Every country has different restrictions on the use of wireless devices.
Since your system is equipped with a wireless device, when traveling
between countries with your system, check with the local Radio
Approval authorities prior to any move or trip for any restrictions on
the use of a wireless device in the destination country.

This transmitter must not be collocated or operation in conjunction with any
other antenna or transmitter.

If your system came equipped with an internal embedded wireless
device, do not operate the wireless device unless all covers and shields
are in place and the system is fully assembled.

Some circumstances require restrictions on wireless devices. Examples of
common restrictions are listed below:

Wireless devices are not user serviceable. Do not modify them in any
way. Modification to a wireless device will void the authorization to
use it. Contact manufacturer for service.

Radio frequency wireless communication can interfere with
equipment on commercial aircraft. Current aviation regulations
require wireless devices to be turned off while traveling in an airplane.
IEEE 802.11 (also known as wireless Ethernet) and Bluetooth
communication devices are examples of devices that provide wireless
communication.

Only use drivers approved for the country in which the device will be
used. See the manufacturer System Restoration Kit, or contact
manufacturer Technical Support for additional information.

21

In environments where the risk of interference to other devices or
services is harmful or perceived as harmful, the option to use a wireless
device may be restricted or eliminated. Airports, Hospitals, and
Oxygen or flammable gas laden atmospheres are limited examples
where use of wireless devices may be restricted or eliminated. When in
environments where you are uncertain of the sanction to use wireless
devices, ask the applicable authority for authorization prior to use or
turning on the wireless device.

Israel only
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China only
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Copyright
© 2013 Samsung Electronics Co., Ltd. All rights reserved.
This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.
Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.
•

Samsung and the Samsung logo are trademarks of Samsung Electronics Co., Ltd.

•

Microsoft, Windows, Windows Vista, Windows 7, Windows 8 and Windows Server 2008 R2 are either registered trademarks or trademarks of Microsoft
Corporation.

•

Google, Picasa, Google Docs, Android and Gmail are either registered trademarks or trademarks of Google Inc.

•

Google Cloud Print is a trademark of Google Inc.

•

iPad, iPhone, iPod touch, Mac and Mac OS are trademarks of Apple Inc., registered in the U.S and other countries.
AirPrint and the AirPrint logo are trademarks of Apple Inc.

•

All other brand or product names are trademarks of their respective companies or organizations.

Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.
REV. 4.00
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User’s Guide
ADVANCED
ADVANCED
This guide provides information about installation, advanced configuration,
operation and troubleshooting on various OS environments.
Some features may not be available depending on models or countries.

BASIC
This guide provides information concerning installation, basic operation and troubleshooting
on windows.

ADVANCED
1. Software Installation

3. Special Features

Installation for Mac

84

Altitude adjustment

130

Reinstallation for Mac

85

Changing the default print settings

131

Installation for Linux

86

Setting your machine as a default machine

132

Reinstallation for Linux

87

Using advanced print features

133

Mac printing

140

Linux printing

142

2. Using a Network-connected
Machine

4. Useful Management Tools
Useful network programs

89

Wired network setup

90

Accessing management tools

145

IPv6 configuration

91

Easy Capture Manager

146

Wireless network setup

93

Samsung AnyWeb Print

147

Samsung Mobile Print

121

Easy Eco Driver

148

Using the NFC feature

122

Using SyncThru™ Web Service

149

Google Cloud Print™

124

Using Samsung Easy Printer Manager

151

AirPrint

127

Using Samsung Printer Status

154

Using Samsung Printer Experience

156

81

ADVANCED
5. Troubleshooting
Paper feeding problems

163

Power and cable connecting problems

164

Printing problems

165

Printing quality problems

169

Operating system problems

177
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1. Software Installation
This chapter provides instructions for installing essential and helpful software for use in an environment where the
machine is connected via a cable. A locally connected machine is a machine directly attached to your computer using
the cable.

• Installation for Mac

84

• Reinstallation for Mac

85

• Installation for Linux

86

• Reinstallation for Linux

87

• If you are a Windows OS user, refer to the "Installing the driver locally" on page 22 for
installing the machine’s driver.
• Only use a USB cable no longer then 3 meter (118 inches).

Installation for Mac
1

Make sure that the machine is connected to your computer and
powered on.

10

Select USB Connected Printer on the Printer Connection Type and
click Continue.

2

Insert the supplied software CD into your CD-ROM drive.

11

Click Add Printer button to select your printer and add it to your printer
list.

12

After the installation is finished, click Close.

3

Double-click the CD-ROM icon that appears on your Mac desktop.
•

4
5
6
7
8

For Mac OS X 10.8, double-click the CD-ROM that appears on Finder.

Double-click the MAC_Installer folder > Installer OS X icon.
Click Continue.
Read the license agreement and click Continue.
Click Agree to agree to the license agreement.
Click Install. All components necessary for machine operations will be
installed.
If you click Customize, you can choose individual components to install.

9

Enter the password and click OK.
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Reinstallation for Mac
If the printer driver does not work properly, uninstall the driver and reinstall it.

1

Open the Applications folder > Samsung > Printer Software
Uninstaller.

2
3
4
5

To uninstall printer software, click Continue.
Check the program you want to delete and click Uninstall.
Enter the password and click OK.
After the uninstallation is finished, click Close.

If a machine has already been added, delete it from the Print Setup Utility
or Print & Fax.
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Installation for Linux
You need to download Linux software packages from the Samsung website to
install the printer software (http://www.samsung.com > find your product >
Support or Downloads).

1

Installing the Unified Linux Driver

8
9
10
11

When installation finished, launch printing utility(Go to System >
Administration > Printing or execute "system-config-printer"
command in Terminal program).
Click Add button.
Select your printer.
Click Forward button and add it to your system.

You must log in as a super user (root) to install the machine software. If you
are not a super user, ask your system administrator.

1

Make sure that the machine is connected to your computer and
powered on.

2
3

Copy Unified Linux Driver package to your system.

4
5
6

Extract the package.

7

Proceed with installation.

Open Terminal program and go to the folder that you copied the
package to.

Move to uld folder.
Execute "./install.sh" command (If you're not logged in as root, execute
the command with "sudo" as "sudo ./install.sh")
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Reinstallation for Linux
If the printer driver does not work properly, uninstall the driver and reinstall it.

1
2
3

Open Terminal program.

4

Proceed with uninstallation.

Move to uld folder extracted from Unified Linux Driver package.
Execute "./uninstall.sh" command (If you're not logged in as root,
execute the command with "sudo" as "sudo ./uninstall.sh")

1. Software Installation
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2. Using a Networkconnected Machine
This chapter gives you step-by-step instructions for setting up a network connected machine and software.

• Useful network programs

89

• Wired network setup

90

• IPv6 configuration

91

• Wireless network setup

93

• Samsung Mobile Print

121

• Using the NFC feature

122

• Google Cloud Print™

124

• AirPrint

127

Supported optional devices and features may differ according to your model (see "Features by
models" on page 6).

Useful network programs
There are several programs available to setup the network settings easily in a
network environment. For the network administrator especially, managing
several machines on the network is possible.

• Before using the programs below, set the IP address first.
• Some features and optional goods may not be available depending on
model or country (see "Features by models" on page 6).

2

SyncThru™ Web Admin Service
Web-based machine management solution for network administrators.
SyncThru™ Web Admin Service provides you with an efficient way of managing
network devices and lets you remotely monitor and troubleshoot network
machines from any site with corporate Internet access.
•

Download this program from http://solution.samsungprinter.com.

1

SyncThru™ Web Service
The web server embedded on your network machine allows you to do the
following tasks (see "IPv6 address configuration" on page 92):
•

Check the supplies information and status.

•

Customize machine settings.

•

Configure the network parameters necessary for the machine to connect to
various network environments.

2. Using a Network-connected Machine
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Wired network setup
3

Printing a network configuration report
You can print Network Configuration Report from the machine’s control panel
that will show the current machine’s network settings. This will help you to set
up a network.
•

Press the

(WPS) button formore than 10 seconds on the control panel.

Using this Network Configuration Report, you can find your machine’s MAC
address and IP address.
For example:
•

MAC Address: 00:15:99:41:A2:78

•

IP Address: 165.254.192.192

2. Using a Network-connected Machine
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IPv6 configuration
IPv6 is supported properly only in Windows Vista or higher.

In the IPv6 network environment, follow the next procedure to use the IPv6
address.

4
5
6
7

Click TCP/IPv6 on the left pane of the website.
Check the IPv6 Protocol check box to activate IPv6.
Click the Apply button.
Turn the machine off and turn it on again.

4

From the SyncThru™ Web Service

Activating IPv6

1

Access a web browser, such as Internet Explorer, from Windows. Enter
the machine IP address (http://xxx.xxx.xxx.xxx) in the address field and
press the Enter key or click Go.

2

If it’s your first time logging into SyncThru™ Web Service you need to
log-in as an administrator. Type in the below default ID and password.
We recommend you to change the default password for security
reasons.

3

•

ID: admin

•

Password: sec00000

• You can also set the DHCPv6.
• To manually set the IPv6 address:
Check the Manual Address check box. Then, the Address/Prefix text
box is activated. Enter the rest of the address
(e.g.,:3FFE:10:88:194::AAAA. “A” is the hexadecimal 0 through 9, A
through F).

When the SyncThru™ Web Service window opens, move the mouse
cursor over the Settings of the top menu bar and then click Network
Settings.
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IPv6 configuration
IPv6 address configuration

1

Start a web browser, such as Internet Explorer, that supports IPv6
addressing as a URL.

2

Select one of the IPv6 addresses (Link-local Address, Stateless
Address, Stateful Address, Manual Address) from Network
Configuration Report (see "Printing a network configuration report" on
page 90).

3

•

Link-local Address: Self-configured local IPv6 address (Address
starts with FE80).

•

Stateless Address: Automatically configured IPv6 address by a
network router.

•

Stateful Address: IPv6 address configured by a DHCPv6 server.

•

Manual Address: Manually configured IPv6 address by a user.

Enter the IPv6 addresses (e.g.,: http://[FE80::215:99FF:FE66:7701]).

Address must be enclosed in '[ ]' brackets.
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Wireless network setup
Wireless network name and Network Password
Make sure your machine supports wireless networking. Wireless
networking may not be available depending on the model (see "Features by
models" on page 6).

Wireless networks require higher security, so when an access point is first set up,
a network name (SSID), the type of security used, and a Network Password are
created for the network. Ask your network administrator about this information
before proceeding with the machine installation.

5

Getting started

Understanding your network type
Typically, you can only have one connection between your computer and the
machine at a time.
Infrastructure mode
This is an environment generally used for homes and SOHOs
(Small Office/ Home Office). This mode uses an access point to
communicate with the wireless machine.
Ad hoc mode
This mode does not use an access point. The wireless
computer and wireless machine communicate directly.
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Wireless network setup
6

Introducing wireless set up methods
You can set wireless settings either from the machine or the computer. Choose the setting method from the below table.

Some wireless network installation types may not be available depending on the model or country.

Set up method

Connecting method
From the computer

Description & Reference
Windows user, see "Access point via USB cable" on page 99.
Windows user, see "Access point without a USB cable (recommended)" on page 102.
• Mac user, see "Access point via USB cable" on page 107.

With Access Point

• Mac user, see "Access point without a USB cable (recommended)" on page 109
From the machine’s control
panel

• See "Connecting in PBC mode" on page 97.
• See "Connecting in PIN mode" on page 97.
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Wireless network setup
Set up method
Without Access Point

Connecting method
From the computer

Description & Reference
Windows user, see "Ad hoc via USB cable" on page 104.
Mac user, see "Ad hoc via USB cable" on page 112.

Wi-Fi Direct setup

See "Setting up Wi-Fi Direct" on page 116.

• If problems occur during wireless set up or driver installation, refer to the troubleshooting chapter (see "Troubleshooting" on page 117).
• It is strongly recommended that you set the password on Access Points. If you do not set the password on Access Points, they might be exposed to illegal access
from unknown machines including PCs, smart phones and printers. Refer to the Access Point user' guide for password settings.
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Wireless network setup
Choosing your type

7

Using the WPS button
There are two methods available to connect your machine to a wireless network
If your machine and an access point (or wireless router) support Wi-Fi Protected
Setup™ (WPS), you can easily configure the wireless network settings by
pressing the

(WPS) button on the control panel without a computer.

• If you want to use the wireless network using the infrastructure mode,
make sure that the network cable is disconnected from the machine.
Using the WPS (PBC) button or entering the PIN from the computer to
connect to the access point (or wireless router) varies depending on the
access point (or wireless router) you are using. Refer to the user's guide
of the access point (or wireless router) you are using.
• When using the WPS button to set the wireless network, security settings
may change. To prevent this, lock the WPS option for the current wireless
security settings. The option name may differ depending on the access
point (or wireless router) you are using.

using the

(WPS) button on the control panel.

The Push Button Configuration (PBC) method allows you to connect your
machine to a wireless network by pressing both the
(WPS) button on the
control panel of your machine and the WPS (PBC) button on a Wi-Fi Protected
Setup™ WPS-enabled access point (or wireless router) respectively.
The Personal Identification Number (PIN) method helps you connect your
machine to a wireless network by entering the supplied PIN information on a WiFi Protected Setup™ WPS-enabled access point (or wireless router).
Factory default in your machine is PBC mode, which is recommended for a
typical wireless network environment.

Items to prepare
•

Check if the access point (or wireless router) supports Wi-Fi Protected
Setup™ (WPS).

•

Check if your machine supports Wi-Fi Protected Setup™ (WPS).

•

Networked computer (PIN mode only)
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Wireless network setup
Connecting in PBC mode

1

Press and hold the
(WPS) button on the control panel for about 2 - 4
seconds until the status LED blinks quickly.

Connecting in PIN mode

1

The machine starts connecting to the wireless network. The LED blinks
slowly for up to two minutes until you press the PBC button on the
access point (or wireless router).

2

b When the machine is successfully connected to the wireless
network, the WPS LED light stays on.

3

In ready mode, Press and hold the
(WPS) button on the button
formore than ten seconds on the control panel.
You can find your machine’s PIN.

Press the WPS (PBC) button on the access point (or wireless router).
a The light blinks fast on the WPS LED. The machine is connecting to
the access point (or wireless router).

The network configuration report, including PIN, must be printed (see
"Printing a network configuration report" on page 90).

2

Press and hold the
(WPS) button on the control panel for more than
4 seconds until the status LED stays on.
The machine starts connecting to the access point (or wireless router).

3

Insert the supplied software CD into your CD-ROM drive, and follow the
instructions in the window to set up the wireless network.

You need to enter the eight-digit PIN within two minutes on the
computer that is connected to the access point (or wireless router).
The LED blinks slowly for up to two minutes until you enter the eightdigit PIN.
The WPS LED blinks in the order below:
a The light blinks fast on the WPS LED. The machine is connecting to
the access point (or wireless router).
b When the machine is successfully connected to the wireless
network, the WPS LED light stays on.

4

Insert the supplied software CD into your CD-ROM drive, and follow the
instructions in the window to set up the wireless network.
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Wireless network setup
Re-connecting to a network

Disconnecting from a network

When the wireless function is off, the machine automatically tries to re-connect
to the access point (or wireless router) with the previously used wireless
connection settings and address.

To disconnect the wireless network connection, press the
the control panel for more than two seconds.

In the following cases, the machine automatically re-connects to the
wireless network:
• The machine is turned off and on again.
• The access point (or wireless router) is turned off and on again.

(WPS) button on

•

When the Wi-Fi network is in idle mode: The machine is immediately
disconnected from the wireless network and the WPS LED turns off.

•

When the Wi-Fi network is being used: While the machine waits until the
current job is finished, the light blinks fast on the WPS LED. Then, the
wireless network connection is automatically disconnected and the WPS
LED turns off.

Canceling the connection process
To cancel the wireless network connection when the machine is connecting to
the wireless network, press and release the

(Power) button on the control

panel. You need to wait 2 minutes to re-connect to the wireless network.
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Wireless network setup
8

Setup using Windows

3

Insert the supplied software CD into your CD-ROM drive.

Shortcut to the Samsung Easy Wireless Setup program without the CD: If
you have installed the printer driver once, you can access the Samsung
Easy Wireless Setup program without the CD (see "Accessing
management tools" on page 145).

If the installation window does not appear, click Start > All programs >
Accessories > Run.
X:\Setup.exe replacing “X” with the letter, which represents your CDROM drive and click OK.

Access point via USB cable

•

Items to prepare
•

Access point

•

Network-connected computer

•

Software CD that was provided with your machine

•

A machine installed with a wireless network interface

•

USB cable

For Windows 8,
If the installation window does not appear, from Charms, select
Search > Apps and search for Run. Type in X:\Setup.exe, replacing
“X” with the letter that represents your CD-ROM drive and click OK.
If “Tap to choose what happens with this disc.” pop-up window
appears, click the window and select Run Setup.exe.

4

Review and accept the installation agreements in the installation
window. Then, click Next.

Creating the infrastructure network

1
2

Check wheter the USB cable is connected to the machine.
Turn on your computer, access point, and machine.
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5

6

Select Wireless network connection on the Printer Connection Type
screen. Then, click Next.

7

Select Using a USB cable on the Select the Wireless Setup Method
screen. Then, click Next.

8

After searching, the window shows the wireless network devices. Select
the name (SSID) of the access point you want to use and click Next.

On the Are you setting up your printer for the first time? screen, select
Yes, I will set up my printer's wireless network. Then, click Next.
If your printer is already connected on the network, select No, my
printer is already connected to my network.

If you cannot find the network name you want to choose, or if you want to
set the wireless configuration manually, click Advanced Setting.
• Enter the wireless Network Name: Enter the SSID of the access point
(SSID is case-sensitive).
• Operation Mode: Select Infrastructure.
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key
can access the network.
2. Using a Network-connected Machine
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WPA Personal or WPA2 Personal: Select this option to authenticate the
print server based on a WPA Pre-Shared Key. This uses a shared secret key
(generally called Pre Shared Key pass phrase), which is manually
configured on the access point and each of its clients.

9

If your printer supports Wi-Fi Direct, the following screen appears.
Click Next.

• Encryption: Select the encryption (None, WEP64, WEP128, TKIP, AES,
TKIP AES).
• Network Password: Enter the encryption network password value.
• Confirm Network Password: Confirm the encryption network
password value.
• WEP Key Index: If you are using WEP Encryption, select the appropriate
WEP Key Index.

The wireless network security window appears when the access point has
security settings.
Enter the Network Password of the access point (or router).
• Wi-Fi Direct option appears on the screen only if your printer supports
this feature.
• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager
(see "Setting up Wi-Fi Direct" on page 116).
• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name
and the maximum length is 22 characters.
• Password setting is the numeric string, and the size is 8 ~ 64 characters.

10

When the wireless network set up is completed, disconnect the USB
cable between the computer and machine. Click Next.
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11
12

Select the components to be installed.
Follow the instructions in the installation window.

Access point without a USB cable (recommended)

Creating the infrastructure network

1
2

Turn on your computer, access point, and machine.
Insert the supplied software CD into your CD-ROM drive.

Items to prepare
•

WiFi-enabled PC running Windows 7 or higher and an access point (router)

•

Software CD that was provided with your machine

•

A machine installed with a wireless network interface

If the installation window does not appear, click Start > All programs >
Accessories > Run.
X:\Setup.exe replacing “X” with the letter, which represents your CDROM drive and click OK.

While setting the wireless network, the machine uses PC's wireless LAN. You
might not be able to connect to the Internet.

•

For Windows 8,
If the installation window does not appear, from Charms, select
Search > Apps and search for Run. Type in X:\Setup.exe, replacing
“X” with the letter that represents your CD-ROM drive and click OK.
If “Tap to choose what happens with this disc.” pop-up window
appears, click the window and select Run Setup.exe.

3

Review and accept the installation agreements in the installation
window. Then, click Next.
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4

5

Select Wireless network connection on the Printer Connection Type
screen. Then, click Next.

On the Are you setting up your printer for the first time? screen, select
Yes, I will set up my printer's wireless network. Then, click Next.

6

Select Using a direct wireless connection on the Select the Wireless
Setup Method screen. Then, click Next.

Even if your computer is running Windows 7 or higher, you cannot use this
feature if your PC does not support wireless network. Set the wireless
network using a USB cable (see "Access point via USB cable" on page 99).

If your printer is already connected on the network, select No, my
printer is already connected tomy network.

2. Using a Network-connected Machine
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If below screen appears, press the
panel within 2 minutes.

(WPS) button from the control

Ad hoc via USB cable
If you do not have an access point (AP), you may still connect the machine
wirelessly to your computer by setting up an ad-hoc wireless network by
following the simple steps below.

Items to prepare

7
8

•

Network-connected computer

•

Software CD that was provided with your machine

•

A machine installed with a wireless network interface

•

USB cable

When the wireless network set up is completed, click Next.
Follow the instructions in the installation window.
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Creating the ad hoc network in Windows

1
2

4

Select Wireless network connection on the Printer Connection Type
screen. Then, click Next.

5

On the Are you setting up your printer for the first time? screen, select
Yes, I will set up my printer's wireless network. Then, click Next.

Turn on your computer and the wireless network machine.
Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs >
Accessories > Run.
X:\Setup.exe replacing “X” with the letter, which represents your CDROM drive and click OK.
•

For Windows 8,
If the installation window does not appear, from Charms, select
Search > Apps and search for Run. Type in X:\Setup.exe, replacing
“X” with the letter that represents your CD-ROM drive and click OK.
If “Tap to choose what happens with this disc.” pop-up window
appears, click the window and select Run Setup.exe.

3

Review and accept the installation agreements in the installation
window. Then, click Next.

If your printer is already connected on the network, select No, my
printer is already connected tomy network.

6

Select Using a USB cable on the Select the Wireless Setup Method
screen. Then, click Next.

7

After searching the wireless networks, a list of wireless networks your
machine has searched appears. Click Advanced Setting.

2. Using a Network-connected Machine
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• Enter the wireless Network Name: Enter the SSID name you want (SSID
is case-sensitive).
• Operation Mode: Select ad hoc.
• Channel: Select the channel. (Auto Setting or 2412 MHz to 2467 MHz).
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key
can access the network.
• Encryption: Select the encryption (None, WEP64, WEP128).
• Network Password: Enter the encryption network password value.
• Confirm Network Password: Confirm the encryption network
password value.
• WEP Key Index: If you are using WEP Encryption, select the appropriate
WEP Key Index.
The wireless network security window appears when the ad hoc network
has security enabled.
Select Open System or Shared Key for the authentication and click Next.
• WEP (Wired Equivalent Privacy) is a security protocol preventing
unauthorized access to your wireless network. WEP encrypts the data
portion of each packet exchanged on a wireless network using a 64-bit
or 128-bit WEP encryption key.

Before entering the IP address for the machine, you must know the
computer’s network configuration information. If the computer’s network
configuration is set to DHCP, the wireless network setting should also be
DHCP. Likewise, if the computer’s network configuration is set to Static, the
wireless network setting should also be Static.
If your computer is set to DHCP and you want to use the Static wireless
network setting, you must contact the network administrator to get the
static IP address.
• For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is shown in
the Wireless Network Setting Confirm window. If it shows Static, click
Change TCP/IP to change the assignment method to Receive IP
address automatically (DHCP).
• For the Static method
If the IP address assignment method is Static, check if Static is shown in
the Wireless Network Setting Confirm window. If it shows DHCP, click
Change TCP/IP to enter the IP address and other network configuration
values for the machine.
For example,
If the computer’s network information is as shown follows:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as below:
- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

8

The window showing the wireless network setting appears. Check the
settings and click Next.

- Gateway: 169.254.133.1

2. Using a Network-connected Machine
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9
10

The Wireless Network Setting Complete window appears. Click Next.

11

Follow the instructions in the installation window.

When the wireless network settings are completed, disconnect the USB
cable between the computer and machine. Click Next.

1

Make sure that the machine is connected to your computer andpowered
on.

2

Insert the supplied software CD into your CD-ROM drive.

3

Double-click the CD-ROM icon that appears on your Mac desktop.

9

Setup using Mac

Access point via USB cable

•

Items to prepare
•

Access point

•

Network-connected printer

•

Software CD that was provided with your machine

•

A machine installed with a wireless network interface

•

USB cable

4
5
6
7
8

For Mac OS X 10.8, double-click the CD-ROM that appears on Finder.

Double-click the MAC_Installer folder > Installer OS X icon.
Click Continue.
Read the license agreement and click Continue.
Click Agree to agree to the license agreement.
Click Install. All components necessary for machine operations will be
installed.
If you click Customize, you can choose individual components to install.

9

Enter the password and click OK.
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10

Select Configuration of Wireless network on the Printer Connection
Type and click Continue.

11

If Wireless Settings screen appears, select Using a USB cable and click
Next.
If the screen does not appear, go to step 15.
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12

After searching, the window shows the wireless network devices. Select
the name (SSID) of the access point you want to use and click Next.

13

• Wi-Fi Direct option appears on the screen only if your printer supports
this feature.

When you set the wireless configuration manually, click Advanced Setting.
• Enter the wireless Network Name: Enter the SSID of the access point
(SSID is case-sensitive).

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager
(see "Setting up Wi-Fi Direct" on page 116).

• Operation Mode: Select Infrastructure.

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name
and the maximum length is 22 characters.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the
print server based on the WPA Pre-Shared Key. This uses a shared secret
key (generally called Pre Shared Key pass phrase) that is manually
configured on the access point and each of its clients.
• Encryption: Select the encryption. (None, WEP64, WEP128, TKIP, AES,
TKIP, AES)
• Network Password: Enter the encryption network password value.
• Confirm Network Password: Confirm the encryption network
password value.

The window showing the wireless network setting appears. Check the
settings and click Next.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

14
15

The Wireless Network Setting Complete window appears. Click Next.
When the wireless network settings are completed, disconnect the USB
cable between the computer and machine. Click Next.

Access point without a USB cable (recommended)
Items to prepare

• WEP Key Index: If you are using WEP Encryption, select the appropriate
WEP Key Index.

•

WiFi-enabled Mac running Mac OS 10.7 or higher and an access point
(router)

The wireless network security window appears when the access point has
security enabled.

•

Software CD that was provided with your machine

Enter the Network Password of the access point (or router).

•

A machine installed with a wireless network interface

2. Using a Network-connected Machine
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1

Make sure that the machine is connected to your computer andpowered
on.

2

Insert the supplied software CD into your CD-ROM drive.

3

Double-click the CD-ROM icon that appears on your Mac desktop.
•

4
5
6
7
8

10

Select Configuration of Wireless network on the Printer Connection
Type and click Continue.

For Mac OS X 10.8, double-click the CD-ROM that appears on Finder.

Double-click the MAC_Installer folder > Installer OS X icon.
Click Continue.
Read the license agreement and click Continue.
Click Agree to agree to the license agreement.
Click Install. All components necessary for machine operations will be
installed.
If you click Customize, you can choose individual components to install.

9

Enter the password and click OK.
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11

If Wireless Settings screen appears, select Using a direct wireless
connection and click Next.

If below screen appears, press the

If the screen does not appear, go to step 13.

within 2 minutes.

12
13

(WPS) button from the control panel

When the wireless network set up is completed, click Next.
After the installation is finished, click Close.
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Ad hoc via USB cable

3

Double-click the CD-ROM icon that appears on your Mac desktop.
•

If you do not have an access point (AP), you may still connect the machine
wirelessly to your computer by setting up an ad hoc wireless network by
following these simple directions.

Items to prepare
•

Network-connected computer

•

Software CD that was provided with your machine

•

A machine installed with a wireless network interface

•

USB cable

Creating the ad hoc network in Mac

1

Make sure that the machine is connected to your computer andpowered
on.

2

Insert the supplied software CD into your CD-ROM drive.

4
5
6
7
8

For Mac OS X 10.8, double-click the CD-ROM that appears on Finder.

Double-click the MAC_Installer folder > Installer OS X icon.
Click Continue.
Read the license agreement and click Continue.
Click Agree to agree to the license agreement.
Click Install. All components necessary for machine operations will be
installed.
If you click Customize, you can choose individual components to install.

9

Enter the password and click OK.
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10

Select Configuration of Wireless network on the Printer Connection
Type and click Continue.

11

After searching the wireless networks, a list of wireless networks your
machine has searched appears. Click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID name (SSID is casesensitive).
• Operation Mode: Select ad hoc.
• Channel: Select the channel (Auto Setting or 2412 MHz to 2467 MHz).
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key
can access the network.
• Encryption: Select the encryption (None, WEP64, WEP128).
• Network Password: Enter the encryption network password value.
• Confirm Network Password: Confirm the encryption network
password value.
• WEP Key Index: If you are using WEP Encryption, select the appropriate
WEP Key Index.
The wireless network security window appears when the ad hoc network
has security setting.
Select Open System or Shared Key for the authentication and click Next.
• WEP (Wired Equivalent Privacy) is a security protocol preventing
unauthorized access to your wireless network. WEP encrypts the data
portion of each packet exchanged on a wireless network using a 64-bit
or 128-bit WEP encryption key.
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12

The window showing the wireless network settings appears. Check the
settings and click Next.

- Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)
- Gateway: 169.254.133.1

Before entering the IP address for the machine, you must know the
computer’s network configuration information. If the computer’s network
configuration is set to DHCP, the wireless network setting should also be
DHCP. Likewise, if the computer’s network configuration is set to Static, the
wireless network setting should also be Static.

13

If your computer is set to DHCP and you want to use Static wireless network
setting, you must contact the network administrator to get the static IP
address.

14
15

• For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is shown in
the Wireless Network Setting Confirm window. If it shows Static, click
Change TCP/IP to change the assignment method to Receive IP
address automatically (DHCP).
• For the Static method
If the IP address assignment method is Static, check if Static is shown in
the Wireless Network Setting Confirm window. If it shows DHCP, click
Change TCP/IP to enter the IP address and other network configuration
values for the machine.
For example,
If the computer’s network information is shown as follows:

When the window that tells you that the network cable connection is
confirmed appears, disconnect the network cable and click Next..
If the network cable is connected, it may have trouble finding the
machine when configuring the wireless network.
The wireless network connects according to the network configuration.
Wireless network set up is completed. After installation is finished, click
Quit.

After completing the wireless network connection, you need to install a
machine driver to print from an application (see "Installation for Mac" on
page 84).

- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as shown below:
- IP address: 169.254.133.43
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10

11

Turning the Wi-Fi network on/off

1

Check whether the network cable is connected to the machine. If not,
connect the machine with a standard network cable.

2

Start a web browser such as Internet Explorer, Safari, or Firefox and enter
your machine’s new IP address in the browser window.
For example,

3
4

Click Login on the upper right of the SyncThru™ Web Service website.
Type in the ID and Password, then click Login.
•

ID: admin

•

Password: sec00000

Setting the Wi-Fi Direct for mobile printing
Wi-Fi Direct is an easy-to-setup peer-to-peer connecting between method for
your between a printer and mobile device that supports Wi-Fi Direct that
provides a secure connection and better throughput than ad hoc mode.
With Wi-Fi Direct, you can connect your printer to a Wi-Fi Direct network while
concurrently connecting to an access point, You can also use a wired network
and a Wi-Fi Direct network simultaneously so multiple users can access and print
documents both from Wi-Fi Direct and from a wired network.

• You cannot connect to the Internet through the mobile device in use WiFi Direct.
• The supported protocol list may differ from your model, Wi-Fi Direct
networks do NOT support IPv6, network filtering, IPSec, WINS, and SLP
services.
• Up to four mobile devices can connect to Wi-Fi Direct at one time.

5

When the SyncThru™ Web Service window opens, click Network
Settings.

6

Click Wireless > Custom.
You can also turn the Wi-Fi network on/off.
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▪

Setting up Wi-Fi Direct
You can enable Wi-Fi Direct feature by one of the following methods.

Network Password: If your printer is a Group Owner, a Network
Password is required for other mobile devices to connect to your
printer. You can configure a Network Password yourself, or can
remember the given Network Password that is randomly generated
by default.

From the USB cable-connected computer(recommended)
•

After the driver installation is complete, Samsung Easy Printer Manager can
be set and changes in the Wi-Fi Direct can be made.

Samsung Easy Printer Manager is Available for Windowsand Mac OS users
only.

-

From the Start menu, select Programs or All Programs > Samsung
Printers > Samsung Easy Printer Manager > Device Settings >
Network.
▪

Wi-Fi Direct On/Off: Select On to enable.

▪

Device Name: Enter the printer’s name for searching for your
printer on a wireless network. By default, the device name is the
model name.

▪

IP Address: Enter the IP address of the printer. This IP address is
used only for the local network and not for the infrastructure wired
or wireless network. We recommend using the default local IP
address (the default local IP address of the printer for Wi-Fi Direct is
192.168.3.1 )

▪

Group Owner: Activate this option to assign the printer the Wi-Fi
Direct group’s owner. The Group Owner acts similar to a wireless
access point. We recommend activating this option.

Setting up the mobile device
•

After setting up Wi-Fi Direct from the printer, refer to the user manual of the
mobile device you are using to set its Wi-Fi Direct.

•

After setting up Wi-Fi Direct, you need to download the mobile printing
application (For example: Samsung Mobile printer) to print from your
smartphone.

• When you have found the printer you want to connect to from your
mobile device, select the printer and the printer's LED will blink. Press the
WPS button on the printer and it will be connected to your mobile
device.
• If your mobile device does not support WPS, you need to enter the
"Network Password" of a printer instead of pushing the WPS button.
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Connecting Failure - General Connection Error

12

Troubleshooting

•

Your computer is not receiving a signal from your machine. Check the USB
cable and your machine’s power.

Problems during setup or driver installation
Connecting Failure - Connected Wired Network
Printers Not Found
•

Your machine may not be turned on. Turn on your computer and the
machine.

•

USB cable is not connected between your computer and machine. Connect
the machine to your computer using the USB cable.

•

The machine does not support wireless networking. Check the machine's
user's guide included on the software CD supplied with your machine and
prepare a wireless network machine.

Connecting Failure - SSID Not Found

•

Your machine is connected with a wired network cable. Remove the wired
network cable from your machine.

Connecting Failure - Assigning the IP address
•

Cycle the power for the access point (or wireless router) and machine.

PC Connection Error
•

The configured network address is unable to connect between your
computer and machine.
-

For a DHCP network environment

•

The machine is unable to find the network name (SSID) you have selected or
entered. Check the network name (SSID) on your access point and try
connecting again.

The receives the IP address automatically (DHCP) when computer is
configured to DHCP.

•

Your access point is not turned on. Turn on your access point.

If the printing job is not working in DHCP mode, the problem may be caused
by the automatically changed IP address. Compare the IP address between
the product's IP address and the printer port's IP address.

Connecting Failure - Invalid Security
•

Security is not configured correctly. Check the configured security on your
access point and machine.

How to compare:
1 Print the network information report of your printer, and then check the
IP address (see "Printing a network configuration report" on page 90).
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2 Check the printer port's IP address from your computer.
a Click the Windows Start menu.
• For Windows 8, from the Charms, select Search > Settings.
b For Windows XP/Server 2003, select Printer and Faxes.
• For Windows Server 2008/Vista, select Control Panel > Hardware
and Sound > Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.
• For Windows 7/ Windows 8, select Control Panel > Devices and
Printers.
c Right-click your machine.
d For Windows XP/2003/2008/Vista, press Properties.
For Windows 7/ Windows 8 or Windows Server 2008 R2, from context
menus, select the Printer properties.
If Printer properties item has ► mark, you can select other printer
drivers connected with selected printer.
e Click Port tab.
f Click Configure Port.. button.
g Check if Printer Name or IP Address: is the IP address on the network
configuration Sheet.
3 Change the printer port's IP address if it is different from the network
information report's.
If you want to use the software installation CD to change the port IP,
connect to a network printer. Then reconnect the IP address.

-

For example,
If the computer’s network information is as shown below:
▪

IP address: 169.254.133.42

▪

Subnet Mask: 255.255.0.0

Then the machine’s network information should be as below:
▪

IP address: 169.254.133.43

▪

Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

▪

Gateway: 169.254.133.1

For a Static network environment
The machine uses the static address when the computer is configured
to static address.
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Other problems

•

Check whether the access point (or wireless router) has a configured
security (password). If it has a password, refer to the access point (or wireless
router) administrator.

•

Check the machine's IP address. Reinstall the machine driver and change the
settings to connect to the machine on the network. Due to the
characteristics of DHCP, the allocated IP address could change if the
machine is not used for a long time or if the access point has been reset.

If problems occur while using the machine on a network, check the following:

For information on the access point (or wireless router), refer to its own
user's guide.

Register the product's MAC address when you confogure the DHCP server
on the access point (or wireless router). Then you can always use the IP
address that is set with the MAC address. You can identify the Mac address
of your machine by printing a network configuration report (see "Printing a
network configuration report" on page 90).

•

You cannot enable wired and wireless networks at the same time.

•

Your computer, access point (or wireless router), or machine may not be
turned on.

•

Check the wireless reception around the machine. If the router is far from
the machine or there is an obstacle, you might have difficulty receiving the
signal.

•

Check the wireless environment. You might not be able to connect to the
network in the infrastructure environment where you need to type in a
user's information before connecting to the access point (or wireless router).

Cycle the power for the access point (or wireless router), machine, and
computer. Sometimes cycling the power can recover network
communication.

•

This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless
communication types (e.g., Bluetooth) are not supported.

•

When using the ad hoc mode, in operating systems such as Windows Vista,
you might need to set the wireless connection setting every time you use
the wireless machine.

•

You cannot use infrastructure mode and ad hoc mode at the same time for
Samsung wireless network machines.

•

The machine is within the range of the wireless network.

•

•

Check whether firewall software (V3 or Norton) is blocking the
communication.
If the computer and the machine are connected on the same network and it
cannot be found when searching, firewall software might be blocking the
communication. Refer to the user's guide for the software to turn it off and
try searching for the machine again.

•

Check whether the machine's IP address is allocated correctly. You can
check the IP address by printing the network configuration report.
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•

The machine is located away from obstacles that could block the wireless
signal.
Remove any large metal objects between the access point (or wireless
router) and the machine.
Make sure the machine and wireless access point (or wireless router) are not
separated by poles, walls, or support columns containing metal or concrete.

•

The machine is located away from other electronic devices that may
interfere with the wireless signal.
Many devices can interfere with the wireless signal, including a microwave
oven and some Bluetooth devices.

•

Whenever the configuration of your access point (or wireless router)
changes, you must do the product's wireless network setup again.

•

The maximum number of device that can be connected via Wi-Fi Direct is 3.

•

If Wi-Fi Direct is ON, this machine only supports IEEE 802.11 b/g.

•

If the access point is set to work with the 802.11n standard only, it may not
connect to your machine.
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Samsung Mobile Print
13

15

What is Samsung Mobile Print?
Samsung Mobile Print is a free application that enables users to print photos,
documents, and web pages directly from your smartphone or tablet. Samsung
Mobile Print is not only compatible with your Android and iOS smart phones
but also with your iPod Touch and tablet PC. It connects your mobile device to a
network connected Samsung printer or to a wireless printer through a Wi-Fi
access point. Installing a new driver or configuring network settings isn’t
necessary – just simply install the Samsung Mobile Print application, and it will
automatically detect compatible Samsung printers. Besides printing photos,
web pages, and PDFs, scanning is also supported. If you have Samsung
multfunction printer, scan any document into a JPG, PDF, or PNG format for
quick and easy viewing on your mobile device.

Supported Mobile OS
•

Android OS 2.1 or higher

•

iOS 4.0 or higher

16

Supported devices
•

iOS 4.0 or higher: iPod Touch, iPhone, iPad

•

Android 2.3 or higher: Galaxy series and Android mobile device

14

Downloading Samsung Mobile Print
To download Samsung Mobile Print, go to the application store (Samsung
Apps, Play Store, App Store) on your mobile device, and just search for
“Samsung Mobile Print.” You can also visit iTunes for Apple devices on your
computer.
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Using the NFC feature
The NFC(Near Field Communication) printer allows you to directly print/scan
from your cell phone just by holding your cell phone over the NFC tag on your
printer. It does not require installing print driver or connecting to an access
point. You just need NFC supported cell phone. In order to use this feature,
Samsung Mobile Print app needs to be installed on your cell phone.

• Depending on the material of the cell phone cover, NFC recognition may
not work properly.
• Depending on the cell phone you are using, the tranmission speed may
differ.

18

Printing

1

Check that NFC and Wi-Fi Direct features are enabled on your cell phone
and Wi-Fi Direct feature is enabled on your printer (see "Setting up Wi-Fi
Direct" on page 116).

2

Tag the NFC antenna on your cell phone (usually located on the back of
the cell phone) over the NFC tag(
) on your printer.
Wait few seconds for Samsung Mobile Print app to start.

17

Requirements
•

NFC and Wi-Fi Direct enabled, Mobile Print app installed cell phone with
Android OS 4.0 or higher.

Only Android OS 4.1 or higher will automatically enable the Wi-Fi Direct
feature on your cell phone when you enable the NFC feature. We
recommend you to upgrade your cell phone to Android OS 4.1 or higher to
use the NFC feature.

•

Wi-Fi Direct feature enabled printer. Wi-Fi Direct feature is enabled by
default.
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Using the NFC feature
• For some cell phones, NFC antenna might not be located at the back of
the cell phone. Check the location of the NFC antenna on your cell phone
before tagging.

• For some cell phones, NFC antenna might not be located at the back of
the cell phone. Check the location of the NFC antenna on your cell phone
before tagging.

• If error message about changed PIN number appears, enter a changed
PIN number and press OK. Follow the instruction on the app screen to
update the PIN number.

• If error message about changed PIN number appears, enter a changed
PIN number and press OK. Follow the instruction on the app screen to
update the PIN number.

• If you do not have Samsung Mobile Print app installed on your cell
phone, it automatically connects to Samsung Mobile Print app
download page. Download the app and try again.

3

The printer starts printing.

Select the content you want to print.
If neccessary, change the print option by pressing the

4

5

.

Tag the NFC antenna on your cell phone(usually located on the back of
the cell phone) over the NFC tag(
) on your printer.
Wait few seconds for the cell phone to connect to the printer.
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Google Cloud Print™
Google Cloud Print™ is a service that allows you to print to a printer using your
smart phone, tablet, or any other web-connected devices. Just register your
Google account with the printer, and you are ready to use the Google Cloud
Print™ service. You can print your document or email with Chrome OS, Chrome
browser, or a Gmail™/ Google Docs™ application on your mobile device, so you
don’t need to install the printer driver on the mobile device. Refer to the Google
website (http://www.google.com/cloudprint/learn/ or http://
support.google.com/cloudprint) for more information about Google Cloud
Print™.

5

Click Login in the upper right corner of the SyncThru™ Web Service
website.

6

If it’s your first time logging into SyncThru™ Web Service you need to
log-in as an administrator. Type in the below default ID and Password.
We recommend you to change the default password for security
reasons.
•

ID: admin

•

Password: sec00000

19

If the network environment is using a proxy server, you need to configure
the proxy’s IP and port number from Settings > Network Settings >
Google Cloud Print > Proxy Setting. Contact your network service
provider or network administrator for more information.

Registering your Google account to the printer
• Make sure the printer machine is turned on and connected to a wired or
wireless network that has access to the Internet.
• You should create your Google account in the advance.

1
2
3
4

Open the Chrome browser.
Visit www.google.com.

7

When the SyncThru™ Web Service window opens, click Settings >
Network Settings > Google Cloud Print.

8
9

Enter your printer’s name and description.
Click Register.
The confirmation pop-up window appears.

Sign in to the Google website with your Gmail™ address.
Enter your printer’s IP address in the address field and press the Enter key
or click Go.

If you set the browser to block pop-ups, the confirmation window will not
appear. Allow the site to show pop-ups.
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Google Cloud Print™
10
11

Click Finish printer registration.
Click Manage your printers.
Now your printer is registered with Google Cloud Print™ service.
Google Cloud Print™-ready devices will appear in the list.

20

Printing with Google Cloud Print™
The printing procedure varies depending on the application or the device you
are using. You can see the application list that supports Google Cloud Print™
service.

Make sure the printer is turned on and connected to a wired or wireless
network that has access to the Internet.

Printing from an application on mobile device
The following steps are an example of using the Google Docs™ app from
Android mobile phone.

1

Install the Cloud Print application on your mobile device.

If you do not have the application, download it from the application store
such as Android Market or App Store.

2
3
4

Access the Google Docs™ application from your mobile device.
Tap the option
Tap the send

button of the document that you want to print.
button.
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Google Cloud Print™
5
6
7

Tap the Cloud Print

button.

Set the printing options if you want.
Tap Click here to Print.

Printing from the Chrome browser
The following steps are an example of using the Chrome browser.

1
2
3
4
5
6

Run Chrome.
Open the document or email that you want to print.
Click the wrench icon

in the browser’s top right corner.

Click Print. A new tab for printing appears.
Select Print with Google Cloud Print.
Click the Print button.
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AirPrint
Only AirPrint certified machines can use the AirPrint feature. Check the box
your machine came in for the AirPrint certified mark.

AirPrint allows you to wirelessly print directly from iPhone, iPad and
iPod touch running the latest version of iOS.

4

Type in the ID and Password, then click Login. Type in the below default
ID and password. We recommend you to change the default password
for security reasons.
•

ID: admin

•

Password: sec00000

5

When the SyncThru™ Web Service window opens, click Settings >
Network Settings.

6

Click Raw TCP/IP, LPR, IPP or mDNS .

21

Setting up AirPrint

You can enable the IPP protocol or mDNS protocol.

Bonjour(mDNS) and IPP protocols are required on your machine to use the
AirPrint feature. You can enable the AirPrint feature by one of the following
methods.

1
2

Check whether the machine is connected to the network.
Start a web browser such as Internet Explorer, Safari, or Firefox and enter
your machine’s new IP address in the browser window.
For example,

3

Click Login in the upper right of the SyncThru™ Web Service website.
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AirPrint
22

Printing via AirPrint
For example, the iPad manual provides these instructions:

1
2
3
4

Open your email, photo, web page, or document you want to print.
Touch the action icon(

).

Select your printer driver name and option menu to set up.
Touch Print button. Print it out.

Cancelling print job: To cancel the printing job or view the print summary,
click the print center icon (

) in multitasking area. You can click cancel in

the print center.
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3. Special Features
This chapter explains special printing features.

• Altitude adjustment

130

• Changing the default print settings

131

• Setting your machine as a default machine

132

• Using advanced print features

133

• Mac printing

140

• Linux printing

142

The procedures in this chapter are mainly based on Windows 7.

Altitude adjustment
Print quality is affected by atmospheric pressure, which is determined by the
height of the machine above sea level. The following information will guide you
on how to set your machine for the best print quality.
Before you set the altitude value, determine the altitude where you are.

5,000 m
(16,404 ft)

1

4,000 m
(13,123 ft)

2
3,000 m
(9,842 ft)

3
2,000 m
(6,561 ft)

4
1,000 m
(3,280 ft)

5
0

•

1
2
3
4
5

High 4
High 3
High 2
High 1
Normal

For Windows and Mac users, see "Device Settings" on page 153.

If your machine is connected to the network, you can set the altitude via
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 149).
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Changing the default print settings
1

Click the Windows Start menu.
•

2

3
4

For Windows 8, from the Charms, select Search > Settings.

If you want to change the settings for each print job, change it in Printing
Preferences.

For Windows XP/Server 2003, select Printer and Faxes.
•

For Windows Server 2008/Vista, select Control Panel > Hardware
and Sound > Printers.

•

For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.

•

For Windows 7/ Windows 8, select Control Panel > Devices and
Printers.

Right-click on your machine.
For Windows XP/Server 2003/Server 2008/Vista, select Printing
Preferences.
For Windows 7/ Windows 8 or Windows Server 2008 R2, from context
menus, select Printing preferences.

If Printing preferences has a ►, you can select other printer drivers
connected to the selected printer.

5
6

Change the settings on each tab.
Click OK.
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Setting your machine as a default machine
1

Click the Windows Start menu.
•

2

3
4

For Windows 8, from the Charms, select Search > Settings.

For Windows XP/Server 2003, select Printer and Faxes.
•

For Windows Server 2008/Vista, select Control Panel > Hardware
and Sound > Printers.

•

For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.

•

For Windows 7/ Windows 8, select Control Panel > Devices and
Printers.

Select your machine.
Right-click your machine and select Set as Default Printer.

For Windows 7/ Windows 8 or Windows Server 2008 R2, if Set as default
printer has a ►, you can select other printer drivers connected to the
selected printer.
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Using advanced print features
• XPS printer driver: used to print XPS file format.
- The XPS printer driver can be installed only on Windows Vista OS or
higher.
- Install optional memory when an XPS job does not print because the
printer is out of memory.
- For models that provide XPS driver from the Samsung website, http:/
/www.samsung.com > find your product> Support or downloads.

2
3

Click Print.
Type in the destination path and the file name, and then click OK.
For example, c:\Temp\file name.

If you type in only the file name, the file is automatically saved in My
Documents, Documents and Settings, or Users. The saved folder may
differ, depending on your operating system or the application you are
using.

1

Printing to a file (PRN)
You will sometimes need to save the print data as a file.

1

Check the Print to file box in the Print window.
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Using advanced print features
2

Understanding special printer features
You can use advanced printing features when using your machine.
To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print
settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.
• Select the Help or click the
37).

Item
Multiple Pages per Side

button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" on page

Description
Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size
and arranged in the order you specify. You can print up to 16 pages on one sheet.
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Using advanced print features
Item

Poster Printing

Description
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets
together to form one poster-size document.
Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic
tab to make it easier to paste the sheets together.

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to
produce a booklet.
Booklet Printinga

8

9

If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media.

The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see
what paper sizes are available.
If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without
or mark).
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Using advanced print features
Item

Description
Print on both sides of a sheet of paper (duplex).

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper
• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other
page of the document first. After that, a message appears on your computer.
• We recommend not to print on both sides of the special media, such as labels, envelopes, or thick paper. It may cause a paper
jam or damage the machine.
Double-sided Printing
(Manual)a

• Long Edge: This mode is the conventional layout used in bookbinding.

• Short Edge: This mode is the conventional layout used in calendars.

Paper Options

Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or
decrease the document.
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Using advanced print features
Item

Description

Watermark

The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document.

Watermark

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box.
You can enter up to 256 characters. The message displays in the preview window.

(Creating a watermark)

Watermark
(Editing a watermark)

Watermark
(Deleting a watermark)

a
b
c
d
e

To change the print settings from your software application, access Printing Preferences.
Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options.
Click Update to save the changes.
Click OK or Print until you exit the Print window.

a
b
c
d

To change the print settings from your software application, access Printing Preferences.
Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
Select the watermark you want to delete from the Current Watermarks list and click Delete.
Click OK or Print until you exit the Print window.
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Using advanced print features
Item

Description
This option is available only when you use the PCL/SPL printer driver (see "Software" on page 6).

Overlaya

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document.
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay
containing exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not
need to load preprinted letterhead paper in the machine: just print the letterhead overlay on your document.
To use a page overlay, you must create a new page overlay containing your logo or image.

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a
watermark.
• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

Overlay
(Creating a new page
overlay)

a
b
c
d

To save the document as an overlay, access Printing Preferences.
Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
In the Edit Overlay window, click Create.
In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default
is C:\Formover).
e Click Save. The name appears on the Overlay List.
f Click OK or Print until you exit the Print window.
The file is not printed. Instead, it is stored on your computer hard disk drive.
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Using advanced print features
Item
Overlay
(Using a page overlay)

Overlay
(Deleting a page overlay)

Description
a Click the Advanced tab.
b Select the desired overlay from the Text drop-down list.
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file
you want to use.
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window.
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the
Overlay List box.
d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit
a document for printing, asking you to confirm printing an overlay on your document.
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document.
e Click OK or Print until you exit the Print window.
a
b
c
d
e
f

In the Printing Preferences window, click the Advanced tab.
Select Edit in the Text drop down list.
Select the overlay you want to delete from the Overlay List box.
Click Delete.
When a confirming message window appears, click Yes.
Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

a. This option is not available when you use XPS driver.
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Mac printing
4

Changing printer settings

Some features may not be available depending on models or options. It
means that the features are not supported.

You can use advanced printing features when using your machine.
3

Printing a document
When you print with a Mac, you need to check the printer driver settings in each
application you use. Follow the steps below to print from a Mac:

Open an application and select Print from the File menu. The machine name,
which appears in the printer properties window, may differ depending on the
machine in use. Except for the name, the composition of the printer properties
window is similar to the following.

5

1
2

Open the document to print.

3

Choose your paper size, orientation, scaling, other options, and make
sure that your machine is selected. Click OK.

4
5
6

Open the File menu and click Print.

Open the File menu and click Page Setup (Document Setup in some
applications).

Printing multiple pages on one sheet
You can print more than one page on a single sheet of paper. This feature
provides a cost-effective way to print draft copies.

1
2

Open an application, and select Print from the File menu.

3
4

Select the other options to use.

Choose the number of copies and indicate which pages to print.
Click Print.

Select Layout from the drop-down list under Orientation. In the Pages
per Sheet drop-down list, select the number of pages you want to print
on one sheet of paper.

Click Print.
The machine prints the selected number of pages to print on one sheet
of paper.
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Mac printing
6

If you print more than 2 copies, the first copy and the second copy might
print on the same sheet of paper. Avoid printing on both sides of paper
when you are printing more than 1 copy.

Printing on both sides of the paper

Some features may not be available depending on models or options. It
means that the features are not supported.
7

Using help
Before printing in the duplex mode, decide on which edge you will be binding
your finished document. The binding options are, as follows:
•

Long-Edge Binding: This option is the conventional layout used in book
binding.

•

Short-Edge Binding: This option is the type often used with calendars.

1
2
3
4
5

Click the question mark on the bottom-left corner of the window and click on
the topic you want to know about. A pop-up window appears with information
about that option's feature, which is provided from the driver.

From your Mac application, select Print from the File menu.
Select Layout from the drop-down list under Orientation.
Select a binding orientation from the Two-Sided option.
Select the other options to use.
Click Print and the machine prints on both sides of the paper.
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Linux printing
Some features may not be available depending on models or options. It
means that the features are not supported.

Automatic/manual duplex printing may not be available depending on
models. You can alternatively use the lp or lpr printing system or other
applications for odd-even printing.

8

Printing from applications

9

Printing files
There are a lot of Linux applications that allow you to print using Common UNIX
Printing System (CUPS). You can print on your machine from any such
application.

You can print text, image, pdf files on your machine using the standard CUPS,
directly from the command line interface. The CUPS lp or lpr utility allows you to
do that. You can print these files by using below command format.

1
2

Open the document to print.

"lp -d <printer name> -o <option> <file name>"

Open the File menu and click Page Setup (Print Setup in some
applications).

Please refer to lp or lpr man page on your system for more details.

3

Choose your paper size, orientation, and make sure that your machine is
selected. Click Apply.

4
5
6
7
8

Open the File menu and click Print.
Select your machine to print.
Choose the number of copies and indicate which pages to print.
Change other printing options in each tab, if necessary.
Click Print.
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Linux printing
10

Configuring Printer Properties
You can change the default printing options or connection type with Printing
utility supplied by o/s.

1

Launch Printing utility(Go to System > Administration > Printing
menu or execute "system-config-printer" command in Terminal
program).

2
3
4

Select your printer and double-click it.
Change default printing options or connection type.
Click Apply button.
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4. Useful Management
Tools
This chapter introduces management tools provided to help you make full use of your machine.

• Accessing management tools

145

• Samsung AnyWeb Print

147

• Easy Eco Driver

148

• Using SyncThru™ Web Service

149

• Using Samsung Easy Printer Manager

151

• Using Samsung Printer Status

154

• Using Samsung Printer Experience

156

Accessing management tools
Samsung provides a variety of management tools for Samsung printers.

1

Make sure that the machine is connected to your computer and
powered on.

2

From the Start menu, select Programs or All Programs.
•For Windows 8, from Charms, select Search > Apps.

3
4
5

Find Samsung Printers.
Under Samsung Printers, you can see installed management tools.
Click the management tool you want to use.

• After installing the driver, for some management tools, you can access
them directly from the Start screen by clicking on the corresponding tile.
• For Windows 8, after installing the driver, for some management tools,
you can access them directly from the Start screen by clicking on the
corresponding tile.
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Easy Capture Manager
Available for Windows OS users only.

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key. Now you can easily print your captured screen as captured or edited.
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Samsung AnyWeb Print
Available for Windows OS users only.

This tool helps you screen-capture, preview, scrap, and print Windows Internet Explorer pages more easily, than when you use an ordinary program.
Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Easy Eco Driver
Available for Windows OS users only (see "Software" on page 6).

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing.
Easy Eco Driver also allows you simple editing such as removing images and texts, and more. You can save frequently used settings as a preset.
How to use:
1 Open a document to print.
2 Open printing preference window (see "Opening printing preferences" on page 36).
3 From the Favorites tab, select Eco Printing Preview.
4 Click OK > Print in the window. A preview window appears.
5 Select the options you want to apply to the document.
You can see the preview of the applied features.
6 Click Print.

If you want to run Easy Eco Driver every time you print, check Start Easy Eco Driver before printing job checkbox in the Basic tab of the printing preference
window.
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Using SyncThru™ Web Service
1
2

• Internet Explorer 6.0 or higher is the minimum requirement for
SyncThru™ Web Service.
• SyncThru™ Web Service explanation in this user’s guide may differ from
your machine depending on its options or models.

Click Login on the upper right of the SyncThru™ Web Service website.
Type in the ID and Password then click Login.
•ID: admin
•Password: sec00000

• Network model only.
2

SyncThru™ Web Service overview

1

Accessing SyncThru™ Web Service

1

Access a web browser, such as Internet Explorer, from Windows.
Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in
the address field and press the Enter key or click Go.

2

Some tabs may not appear depending on your model.

Your machine’s embedded website opens.

Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to log-in as an
administrator. You can still use SyncThru™ Web Service without logging in but
you won’t have access to Settings tab and Security tab.

Information tab
This tab gives you general information about your machine. You can check
things, such as remaining amount of toner. You can also print reports, such as an
error report.
•

Active Alerts: Shows the alerts that have occurred in the machine and their
severity.

•

Supplies: Shows how many pages are printed and amount of toner left in
the cartridge.

•

Usage Counters: Shows the usage count by print types
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Using SyncThru™ Web Service
•

Current Settings: Shows the machine’s and network’s information.

•

Print information: Prints reports such as system related reports and font
reports.

Settings tab
This tab allows you to set configurations provided by your machine and
network. You need to log-in as an administrator to view this tab.
•

Machine Settings tab: Sets options provided by your machine.

•

Network Settings tab: Shows options for the network environment. Sets
options such as TCP/IP and network protocols.

Security tab
This tab allows you to set system and network security information. You need to
log-in as an administrator to view this tab.
•

System Security: Sets the system administrator’s information and also
enables or disables machine features.

•

Network Security: Sets settings for IPSec and IPv4/IPv6 filtering.

Maintenance tab
This tab allows you to maintain your machine by upgrading firmware and
setting contact information for sending emails. You can also connect to
Samsung website or download drivers by selecting the Link menu.
•

Firmware Upgrade: Upgrade your machine’s firmware.

•

Contact Information: Shows the contact information.

•

Link: Shows links to useful sites where you can download or check
information.

3

Setting the system administrator’s information
This setting is necessary for using the e-mail notification option.

1

Start a web browser, such as Internet Explorer, from Windows.
Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field
and press the Enter key or click Go.

2
3
4

Your machine’s embedded website opens.

5

Click Apply.

From the Security tab, select System Security > System Administrator
Enter the name of the administrator, phone number, location, and email
address.
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Using Samsung Easy Printer Manager
• This feature may not be available depending on model or optional goods
(see "Software" on page 6).
• Available for Windows and Mac OS users only (see "Software" on page 6).
• For Windows, Internet Explorer 6.0 or higher is the minimum
requirement for Samsung Easy Printer Manager.

Open the Applications folder > Samsung folder > Samsung Easy Printer
Manager.
The Samsung Easy Printer Manager interface is comprised of various basic
sections as described in the table that follows:

The screenshot may differ depending on operating system you are using.

Samsung Easy Printer Manager is an application that combines Samsung
machine settings into one location. Samsung Easy Printer Manager combines
device settings as well as printing environments, settings/actions and
launching. All of these features provide a gateway to conveniently use your
Samsung machine. Samsung Easy Printer Manager provides two different user
interfaces for the user to choose from: the basic user interface and the advanced
user interface. Switching between the two interfaces is easy: just click a button.

4

Understanding Samsung Easy Printer Manager
To open the program:
For Windows,
Select Start > Programs or All Programs > Samsung Printers > Samsung
Easy Printer Manager.
•

For Windows 8, from Charms, select Search > Apps> Samsung Printers >
Samsung Easy Printer Manager.

For Mac,
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Using Samsung Easy Printer Manager
Printer list

The Printer List displays printers installed on your
computer and network printers added by network
discovery (Windows only).

Printer
information

This area gives you general information about your
machine. You can check information, such as the
machine’s model name, IP address (or Port name), and
machine status.

1

2

You can view the online User’s Guide.
Troubleshooting button: This button opens the
Troubleshooting Guide when an error occurs.
You can directly open the necessary section in the
user’s guide.

Application
information

3

Includes links for changing to the advanced settings
(switching UI), refresh, preference setting, summary, help,
and about.

Quick links

Displays Quick links to machine specific functions. This
section also includes links to applications in the advanced
settings.

4
If you connect your machine to a network, the
SyncThru™ Web Service icon is enabled.

Contents area

Displays information about the selected machine,
remaining toner level, and paper. The information will vary
based on the machine selected. Some machines do not
have this feature.

Order supplies

Click on the Order button from the supply ordering
window. You can order replacement toner cartridge(s)
from online.

5

6

Select the Help menu or click the
button from the window and click on
any option you want to know about.

The
button is used to change the user
interface to the advanced settings user interface
(see "Advanced settings user interface overview"
on page 153).
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Using Samsung Easy Printer Manager
5

Advanced settings user interface overview
The advanced user interface is intended to be used by the person responsible
for managing the network and machines.

Some menus may not appear in the display depending on options or
models. If so, it is not applicable to your machine.

Device Settings
You can configure various machine settings such as machine setup, paper,
layout, emulation, network, and print information.

Alert Settings (Windows only)
This menu includes settings related to error alerting.
•

Printer Alert: Provides settings related to when alerts will be received.

•

Email Alert: Provides options relating to receiving alerts via email.

•

Alert History: Provides a history of device and toner related alerts.
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Using Samsung Printer Status
The Samsung Printer Status is a program that monitors and informs you of the
machine status.

Icon

Mean
Normal

The machine is in ready mode and experiencing no
errors or warnings.

Warning

The machine is in a state where an error might occur in
the future. For example, it might be in toner low status,
which may lead to toner empty status.

Error

The machine has at least one error.

• Available for Windows users.
• The Samsung Printer Status window and its contents shown in this user’s
guide may differ depending on the machine or operating system in use.
• Check the operating system(s) that are compatible with your machine
(see "System requirements" on page 65).

Description

6

Samsung Printer Status overview
If an error occurs while operating, you can check the error from the Samsung
Printer Status. Samsung Printer Status is installed automatically when you install
the machine software.
You can also launch Samsung Printer Status manually. Go to the Printing
Preferences , click the Basic tab > Printer Status button.
These icons appear on the Windows task bar:

Toner Level

You can view the level of toner remaining in each
toner cartridge. The machine and the number of
toner cartridge(s) shown in the above window may
differ depending on the machine in use. Some
machines do not have this feature.

Option

You can set Printing Job Alert related settings.

1

2
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Using Samsung Printer Status
3

Order Supplies

You can order replacement toner cartridge(s) from
online.

User’s Guide

You can view the online User’s Guide.

This button opens the Troubleshooting
Guide when an error occurs. You can
directly open the troubleshooting section in
the user’s guide.

4

5

Close

Close the window.
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Using Samsung Printer Experience
Samsung Printer Experience is a Samsung application that combines
Samsung machine settings and machine management into one location. You
can set device settings, order supplies, open troubleshooting guides, visit
Samsung’s web site, and check connected machine information. This
application will be automatically downloaded from the Windows Store if the
machine is connected to a computer with an Internet connection.

The screenshot may differ depending on the model you are using.

7

Understanding the Samsung Printer Experience
To open the application,
From the Start screen, select the Samsung Printer Experience (

) tile.

The Samsung Printer Experience interface comprises various useful features as
described in the following table:

1

Printer
Information

This area gives you general information about your
machine. You can check information, such as the
machine’s status, location, IP address, and remaining
toner level.
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Using Samsung Printer Experience
8

2

User Guide

You can view the online User’s Guide. You need to be
connected to the Internet to use this feature.

This button opens the Troubleshooting Guide
when an error occurs. You can directly open the
troubleshooting section in the user’s guide.

Adding/Deleting Printers
If you do not have any printer added to the Samsung Printer Experience, or if
you want to add/delete a printer, follow the instructions below.

You can only add/delete network connected printers.
Order Supplies
3

4

Visit Samsung

Printer Settings
5

6

Device List &
Latest Scanned
Image

Click on this button to order replacement toner
cartridges online. You need to be connected to the
Internet to use this feature.
Links to Samsung printer website. You need to be
connected to the Internet to use this feature.
You can configure various machine settings such as
machine setup, paper, layout, emulation, networking,
and print information through SyncThru™ Web
Service. Your machine needs to be connected to a
network. This button will be disabled if your machine is
connected via USB cable.
The scan list displays devices that supports Samsung
Printer Experience. Under the device, you can see the
latest scanned images. Your machine needs to be
connected to a network to scan from here. This section is
for the users with multi-functional printers.

Adding a printer

1

From the Charms, select Settings.
Or, right-click the Samsung Printer Experience page and select
Settings.

2
3

Select Add Printer
Select the printer you want to add.
You can see the added printer.

If you see

mark, you can also click

mark to add printers.
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Using Samsung Printer Experience
Deleting a printer

9

Printing from Windows 8

1

From the Charms, select Settings.
Or, right-click the Samsung Printer Experience page and select
Settings.

2
3
4

Select Remove Printer
Select the printer you want to delete.
Click Yes.
You can see that the deleted printer is removed from the screen.

This section explains common printing tasks from the Start screen.

Basic printing

1
2
3
4

Open the document to print.
From the Charms, select Devices.
Select your printer from the list
Select the printer settings, such as the number of copies and orientation.
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5

Click the Print button to start the print job.

Cancelling a print job
If the printing job is waiting in the print queue or print spooler, cancel the job as
follows:
•

You can access this window by simply double-clicking the machine icon
(

) in the Windows task bar.

Opening more settings
The screen may appear somewhat different depending on the model or
options.

You can set up more printing parameters.

1
2
3
4

Open the document you want to print.
From the Charms, select Devices.
Select your printer from the list
Click More settings.
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Using Samsung Printer Experience
Basic tab

Advanced tab

Basic

Paper settings

This option allows you to choose the basic printing settings such as copies,
orientation, and document type.

This option allows you to set the basic paper handling specifications.

Eco settings

This option allows you to set the various ways to layout your documents.

Layout settings

This option allows you to choose multiple pages per side to save media.
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Security tab
Some features may not be available depending on the model or options. If
this tab is not shown or disabled, it means that this features are not
supported.

This option is used for printing confidential documents. You need to enter a
password to print using it.

Using the sharing feature
Samsung Printer Experience allows you to print from other applications
installed on the computer using the sharing feature.

This feature is only available for printing jpeg, bmp, tiff, gif, and png file
formats.

1
2
3
4

Select the content you want to print from other application.
From the Charms, select Share > Samsung Printer Experience .
Select the printer settings, such as the number of copies and orientation.
Click the Print button to start the print job.

Job Accounting
This option allows you to print with the given permission.
Confidential Printing
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5. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Paper feeding problems

163

• Power and cable connecting problems

164

• Printing problems

165

• Printing quality problems

169

• Operating system problems

177

Paper feeding problems
Condition

Suggested solutions

Paper jams during printing.

Clear the paper jam.

Paper sticks together.

• Check the maximum paper capacity of the tray .
• Make sure that you are using the correct type of paper.
• Remove paper from the tray and flex or fan the paper.
• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed.

Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine.

• Remove any obstructions from inside the machine.
• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.
• There is too much paper in the tray. Remove excess paper from the tray.
• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming.

• There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, feed
manually in the tray.
• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.
• There may be debris inside the machine. Open the top cover and remove any debris.

Envelopes skew or fail to feed correctly.

Ensure that the paper guides are against both sides of the envelopes.
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Power and cable connecting problems
1

Power
Click this link to open an animation about solving power problems.

Condition
The machine is not receiving power,
or the connection cable between the
computer and the machine is not
connected properly.

Suggested solutions
• Connect the machine to the electricity supply first and press the

(Power) button on the control panel.

• Disconnect the machine’s cable and reconnect it.
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Printing problems
Condition
The machine does not
print.

Possible cause

Suggested solutions

The machine is not receiving power.

Check the power cord connections. Check the power switch and the power source.

The machine is not selected as the default
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:
• The top cover is not closed. Close the top cover.
• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 53).
• No paper is loaded. Load paper (see"Loading paper in the tray" on page 27).
• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 44).
• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 44).
If a system error occurs, contact your service representative.
The connection cable between the computer and
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 18).

The connection cable between the computer and
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job.
You can also try using a different machine cable.

The port setting is incorrect.

Check the Windows printer settings to make sure that the print job is sent to the correct
port. If the computer has more than one port, make sure that the machine is attached to
the correct one.

The machine may be configured incorrectly.

Check the Printing Preferences to ensure that all of the print settings are correct.
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Printing problems
Condition
The machine does not
print.

Possible cause

Suggested solutions

The printer driver may be incorrectly installed.

Uninstall and reinstall the machine’s driver.

The machine is malfunctioning.

Check the display message on the control panel to see if the machine is indicating a
system error. Contact a service representative.

The document size is so big that the hard disk
space of the computer is insufficient to access the
print job.

Get more hard disk space and print the document again.

The output tray is full.

Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print
materials from the wrong
paper source.

The paper option that was selected in the
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab
within the Printing Preferences (see "Opening printing preferences" on page 36).
Select the correct paper source. See the printer driver help screen (see "Using help" on
page 37).

A print job is extremely
slow.

The job may be very complex.

Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank.

The page orientation setting may be incorrect.

Change the page orientation in your application (see "Opening printing preferences" on
page 36). See the printer driver help screen (see "Using help" on page 37).

The paper size and the paper size settings do not
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.Or,
ensure that the paper size in the printer driver settings matches the paper selection in
the software application settings you use (see "Opening printing preferences" on page
36).
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Printing problems
Condition
The machine prints, but
the text is wrong,
garbled, or incomplete.

Pages print, but they are
blank.

Possible cause

Suggested solutions

The machine cable is loose or defective.

Disconnect the machine cable and reconnect. Try a print job that you have already
printed successfully. If possible, attach the cable and the machine to another computer
that you know works and try a print job. Finally, try a new machine cable.

The wrong printer driver was selected.

Check the applicatinon’s printer selection menu to ensure that your machine is selected.

The software application is malfunctioning.

Try printing a job from another application.

The operating system is malfunctioning.

Exit Windows and reboot the computer. Turn the machine off and back on again.

The toner cartridge is defective or out of toner.

Redistribute the toner, if necessary. If necessary, replace the toner cartridge.
• See "Redistributing toner" on page 43.
• See "Replacing the toner cartridge" on page 44.

The file may have blank pages.

Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board,
may be defective.

Contact a service representative.

The machine does not
print PDF files correctly.
Some parts of graphics,
text, or illustrations are
missing.

Incompatibility between the PDF file and the
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image
from the Acrobat printing options.

The print quality of
photos is not good.
Images are not clear.

The resolution of the photo is very low.

It will take longer to print when you print a PDF file as an image.

Reduce the photo size. If you increase the photo size in the software application, the
resolution will be reduced.
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Printing problems
Condition

Possible cause

Suggested solutions

Before printing, the
machine emits vapor near
the output tray.

Using damp/wet paper can cause vapor [white
smoke] during printing.

This is not a problem, just keep printing. If you are bothered by the smoke [vapor], then
replace the paper with fresh paper from an unopened ream.

The machine does not
print special-sized paper,
such as billing paper.

Paper size and paper size setting do not match.

Set the correct paper size in the Custom in Paper tab in Printing Preferences (see
"Opening printing preferences" on page 36).

The printed billing paper
is curled.

The paper type setting does not match.

Change the printer option and try again. Go to Printing Preferences , click Paper tab,
and set type to Thick (see "Opening printing preferences" on page 36).
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem.
Condition
Light or faded print

Suggested Solutions
• If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the
toner cartridge" on page 44).
• The paper may not meet paper specifications; for example, the paper may be too moist or rough.
• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn
the toner save mode off. See the help screen of the printer driver.
• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine
(see "Cleaning the machine" on page 46).
• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page
46). If these steps do not correct the problem, contact a service representative.

The top half of the paper is
printed lighter than the rest of
the paper

The toner might not adhere properly to this type of paper.
• Change the printer option and try again. Go to Printing Preferences , click the Paper tab, and set the paper type to Recycled (see
"Opening printing preferences" on page 36).
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Printing quality problems
Condition
Toner specks

Suggested Solutions
• The paper may not meet specifications; for example, the paper may be too moist or rough.
• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 46).

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c
Dropouts

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 46).

If faded areas, generally rounded, occur randomly on the page:
• A single sheet of paper may be defective. Try reprinting the job.

A aBb C
A aBb C
A aBb C
A aBb C
A aBb C

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.
• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.
• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick or Thicker (see
"Opening printing preferences" on page 36).
If these steps do not correct the problem, contact a service representative.

White Spots

If white spots appear on the page:
• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 46).
• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 46).
If these steps do not correct the problem, contact a service representative.
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Printing quality problems
Condition
Vertical lines

Suggested Solutions
If black vertical streaks appear on the page:
• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the toner cartridge and
install a new one (see "Replacing the toner cartridge" on page 44).
If white vertical streaks appear on the page:
• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page
46). If these steps do not correct the problem, contact a service representative.

Black background

If the amount of background shading becomes unacceptable:
• Change to a lighter weight paper.
• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount
of background shading.
• Remove the old toner cartridge and install a new one (see "Replacing the toner cartridge" on page 44).
• Thoroughly redistribute the toner (see "Redistributing toner" on page 43).

Toner smear

• Clean the inside of the machine (see "Replacing the toner cartridge" on page 44).
• Check the paper type and quality.
• Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on page 44).
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Printing quality problems
Condition
Vertical repetitive defects

Suggested Solutions
If marks repeatedly appear on the printed side of the page at even intervals:
• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install a new one (see
"Replacing the toner cartridge" on page 44).
• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after
a few more pages.
• The fusing assembly may be damaged. Contact a service representative.

Background scatter

A

Background scatter results from bits of toner randomly distributed on the printed page.
• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that
the paper does not absorb too much moisture.
• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams
on the reverse side. Printing on seams can cause problems.
Or select Thick Envelope from the Printing Preferences window (see "Opening printing preferences" on page 36).
• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application
or in Printing Preferences (see "Opening printing preferences" on page 36). Ensure the correct paper type is selected. For example:
If Thicker Paper is selected, but Plain actually used, an overcharging can occur causing this copy quality problem.
• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 43).

Toner particles are around bold
characters or pictures

The toner might not adhere properly to this type of paper.
• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see
"Opening printing preferences" on page 36).
• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain actually used, an overcharging can
occur causing this copy quality problem.
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Printing quality problems
Condition

Suggested Solutions

Misformed characters

• If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew

• Ensure that the paper is loaded properly.
• Check the paper type and quality.
• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave

• Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high temperature and humidity can cause paper curl.
• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.
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Printing quality problems
Condition
Wrinkles or creases

Suggested Solutions
• Ensure that the paper is loaded properly.
• Check the paper type and quality.
• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty

• Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 46).

Solid color or black pages

• The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

A

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on
page 44).
• The machine may require repairing. Contact a service representative.
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Printing quality problems
Condition
Loose toner

Suggested Solutions
• Clean the inside of the machine (see "Cleaning the machine" on page 46).
• Check the paper type and quality.
• Remove the toner cartridge and then, install a new one (see "Replacing the toner cartridge" on page 44).
If the problem persists, the machine may require repair. Contact a service representative.

Character voids

Character voids are white areas within parts of characters that should be solid black:
• You may be printing on the wrong surface of the paper. Remove the paper and turn it around.

A
Horizontal stripes

• The paper may not meet paper specifications.

If horizontally aligned black streaks or smears appear:
• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on
page 44).
If the problem persists, the machine may require repairing. Contact a service representative.
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Printing quality problems
Condition
Curl

Suggested Solutions
If the printed paper is curled or paper does not feed into the machine:
• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.
• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see
"Opening printing preferences" on page 36).

• An unknown image
Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.The high altitude may affect the print quality, such
repetitively appears on a few as loose toner or light imaging. Change the altitude setting for your machine (See "Altitude adjustment" on page 130).
sheets
• Loose toner
• Light print or contamination
occurs
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Operating system problems
2

Common Windows problems
Condition

Suggested solutions

“File in Use” message appears
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”,
“Exception OE”, “Spool 32”, or
“Illegal Operation” messages
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer
timeout error occurred”
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready
mode or after printing has completed, check the connection and/or whether an error has occurred.

Samsung Printer Experience is
not shown when you click more
settings.

Samsung Printer Experience is not installed. Download the app. from the Windows Store and install it.

Machine information is not
displayed when you click the
device in the Devices and
Printers.

Check the Printer properties. Click the Ports tab.
(Control Panel > Devices and Printers > Right-click on your printer icon and select Printer properties)
If the port is set to File or LPT, uncheck them and select TCP/IP, USB, or WSD.

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.
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Operating system problems
3

Common Mac problems
Condition
The machine does not print PDF files
correctly. Some parts of graphics, text, or
illustrations are missing.

Suggested solutions
Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options.

It will take longer to print when you print a PDF file as an image.

Some letters are not displayed normally
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on
the cover page.

When printing a document in Mac with
Acrobat Reader 6.0 or higher, colors
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.

Refer to the Mac User’s Guide that came with your computer for further information on Mac error messages.

5. Troubleshooting

178

Operating system problems
4

Common Linux problems
Condition

Suggested solutions

Printing with more than 2
copies does not work.

The problem occurs on Ubuntu 12.04 due to problem in standard CUPS filter 'pdftops' (actual output point it out exactly) and it has
been fixed already. Updating 'cups-filters' package from version 1.0.17 to version 1.0.18 fixes the problem ('pdftops' is a part of 'cupsfilters' package).

Printing PDF files does not
work.

The problem occurs on openSUSE 12.3 and it has some problem in standard CUPS filter 'pdftops' that may affect certain PDF
documents (it seems this issue relates somehow to fonts used in PDF). Due to this problem, incorrect Postscript is generated and device
failed to print it. We are waiting for the patch.

Unchecking collate option in
Print dialog does not work.

For some distributions, GNOME Print Dialog has an issue handling collate option. As workaround, set the default value of collate option
to 'False' using system's Printing utility(execute "system-config-printer" in Terminal program).

Printing always works with
duplex.

This duplex issue was in Ubuntu 9.10 cups package and was already fixed in security updates for this package, starting from cups
version 1.4.1-5ubuntu2.2

Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.
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Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung products, contact
the Samsung customer care center.

Country/Region
BOTSWANA

Country/Region

Customer Care Center

WebSite

BRAZIL

Customer Care Center

WebSite

0800-726-000

www.samsung.com

0800-124-421

www.samsung.com

4004-0000

ANGOLA

91-726-7864

www.samsung.com

ARGENTINA

0800-333-3733

www.samsung.com

BULGARIA

07001 33 11 , normal tariff

www.samsung.com

ARMENIA

0-800-05-555

www.samsung.com

CAMEROON

7095- 0077

www.samsung.com

AUSTRALIA

1300 362 603

www.samsung.com

1-800-SAMSUNG (726-7864)

www.samsung.com/ca
(English)

AUSTRIA

0810-SAMSUNG (7267864, €
0.07/min)

www.samsung.com

AZERBAIJAN

088-55-55-555

www.samsung.com

8000-4726
BAHRAIN

www.samsung.com/ae
(English)
www.samsung.com/
ae_ar (Arabic)

CANADA

CHILE
CHINA
COLOMBIA

BELARUS

www.samsung.com/
ca_fr (French)
800-SAMSUNG (726-7864)
From mobile 02-24 82 82 00
400-810-5858

www.samsung.com

01-8000112112

www.samsung.com/co

810-800-500-55-500

www.samsung.com

Bogotá: 6001272

02-201-24-18

www.samsung.com/be
(Dutch)

0-800-507-7267

BELGIUM

www.samsung.com/cl

www.samsung.com/
latin (Spanish)

COSTA RICA

www.samsung.com/
latin_en (English)

www.samsung.com/
be_fr (French)

BOLIVIA

800-10-7260

www.samsung.com

CROATIA

062 SAMSUNG (062 726 786)

www.samsung.com

BOSNIA

051 133 1999

www.samsung.com

Cote D’ Ivoire

8000 0077

www.samsung.com
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Country/Region

Customer Care Center

WebSite
www.samsung.com

CYPRUS

8009 4000 only from
landline(+30) 210 6897691 from
mobile and land line

CZECH

800-SAMSUNG (800-726786)

www.samsung.com

DENMARK

70 70 19 70

www.samsung.com

1-800-751-2676

www.samsung.com/
latin (Spanish)

DOMINICA

www.samsung.com/
latin_en (English)
1-800-10-7267

ECUADOR

EGYPT

08000-726786

www.samsung.com

EIRE

0818 717100

www.samsung.com

800-6225

www.samsung.com/
latin (Spanish)

800-7267

www.samsung.com/ee

FINLAND

030-6227 515

www.samsung.com

FRANCE

01 48 63 00 00

www.samsung.com/fr

WebSite
www.samsung.com

GERMANY

GEORGIA

8-800-555-555

www.samsung.com

0800-10077

www.samsung.com

GHANA

GREECE

0302-200077
80111-SAMSUNG (80111 726
7864) only from land line(+30)
210 6897691 from mobile and
land line

www.samsung.com

1-800-299-0013

www.samsung.com/
latin (Spanish)

GUATEMALA

www.samsung.com/
latin_en (English)
800-27919267

HONDURAS

www.samsung.com/
latin_en (English)

ESTONIA

Customer Care Center
0180 5 SAMSUNG bzw.0180 5
7267864* (*0,14 €/Min. aus dem
dt. Festnetz, aus dem Mobilfunk
max. 0,42 €/Min.)

www.samsung.com/
latin (Spanish)
www.samsung.com/
latin_en (English)

EL SALVADOR

Country/Region

www.samsung.com/
latin_en (English)
(852) 3698-4698

HONG KONG

www.samsung.com/
latin (Spanish)

www.samsung.com/hk
(Chinese)
www.samsung.com/
hk_en (English)
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Country/Region
HUNGARY
INDIA

INDONESIA

Customer Care Center

WebSite

06-80-SAMSUNG (726-7864)

www.samsung.com

1800 3000 8282

www.samsung.com/in

Country/Region
LUXEMBURG

Customer Care Center
261 03 710

www.samsung.com

1800-88-9999

www.samsung.com/
my

MEXICO

01-800-SAMSUNG (726-7864)

www.samsung.com

MOLDOVA

0-800-614-40

www.samsung.com

MALAYSIA

1800 266 8282
0800-112-8888

www.samsung.com/id

021-5699-7777

WebSite

IRAN

021-8255

www.samsung.com

MONGOLIA

+7-800-555-55-55

www.samsung.com

ITALIA

800-SAMSUNG (726-7864)

www.samsung.com

MONTENEGRO

020 405 888

www.samsung.com

JAMAICA

1-800-234-7267

www.samsung.com

MOROCCO

080 100 2255

www.samsung.com

JAPAN

0120-327-527

www.samsung.com

NAMIBIA

8197267864

www.samsung.com

800-22273

www.samsung.com/
Levant (English)

NIGERIA

0800-726-7864

www.samsung.com

NETHERLANDS

0900-SAMSUNG (0900-7267864)
(€ 0,10/min)

www.samsung.com

NEW ZEALAND

0800 SAMSUNG (0800 726 786)

www.samsung.com

00-1800-5077267

www.samsung.com/
latin (Spanish)

JORDAN

065777444

KAZAKHSTAN

8-10-800-500-55-500 (GSM:7799) www.samsung.com

KENYA

0800 724 000

www.samsung.com

183-2255 (183-CALL)

www.samsung.com/ae
(English)

KUWAIT

NICARAGUA

www.samsung.com/
latin_en (English)

www.samsung.com/
ae_ar (Arabic)

KYRGYZSTAN

00-800-500-55-500

www.samsung.com

LATVIA

8000-7267

www.samsung.com/lv

LITHUANIA

8-800-77777

www.samsung.com/lt

NORWAY

815-56 480

www.samsung.com
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Country/Region

Customer Care Center
800-SAMSUNG (726-7864)

OMAN

800-7267
PANAMA

WebSite

Customer Care Center

WebSite

www.samsung.com/ae
(English)

0 801-1SAMSUNG(172-678) * lub
+48 22 607-93-33 **

www.samsung.com/pl

www.samsung.com/
ae_ar (Arabic)

* (całkowity koszt połączenia jak
za 1 impuls według taryfy
operatora)
** (koszt połączenia według
taryfy operatora)

www.samsung.com/
latin_en (English)

PORTUGAL

808 20-SAMSUNG (808 20 7267)

www.samsung.com

PUERTO RICO

1-800-682-3180

www.samsung.com

800-2255 (800-CALL)

www.samsung.com/ae
(English)

98005210001

www.samsung.com
www.samsung.com

PERU

0-800-777-08 (Only from
landline)

QATAR

336-8686 (From HHP & landline)

PHILIPPINES

POLAND

www.samsung.com/
latin (Spanish)

PARAGUAY

1-800-10-SAMSUNG(726-7864)
for PLDT

Country/Region

www.samsung.com/
ae_ar (Arabic)

www.samsung.com/ph
ROMANIA

www.samsung.com

1-800-3-SAMSUNG(726-7864) for
Digitel

08008 SAMSUNG (08008 726
7864)TOLL FREE No.

RUSSIA

800-00-0077

www.samsung.com

1-800-8-SAMSUNG(726-7864) for
Globe

SAUDI ARABIA

9200-21230

www.samsung.com/sa
(Arabic)

SENEGAL

8-800-555-55-55

www.samsung.com

SERBIA

+381 11 321 6899 (old number
still active 0700 7267864)

www.samsung.com

SINGAPORE

1800-SAMSUNG (726-7864)

www.samsung.com

02-5805777
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Country/Region

Customer Care Center

WebSite

Country/Region

Customer Care Center

WebSite

SLOVAKIA

0800 - SAMSUNG(0800-726 786)

www.samsung.com

U.S.A

1-800-SAMSUNG (726-7864)

www.samsung.com

SOUTH AFRICA

0860 SAMSUNG (726-7864)

www.samsung.com

UGANDA

0800 300 300

www.samsung.com

SPAIN

902-1-SAMSUNG(902 172 678)

www.samsung.com

0-800-502-000

SWEDEN

0771 726 7864 (SAMSUNG)

www.samsung.com

www.samsung.com/ua
(Ukrainian)

SWITZERLAND

SYRIA
TADJIKISTAN
TAIWAN
TANZANIA
THAILAND

0848-SAMSUNG (7267864, CHF
0.08/min)

18252273

UKRAINE

www.samsung.com/
ua_ru (Russian)

www.samsung.com/ch
www.samsung.com/
ch_fr/
www.samsung.com/
Levant (English)

URUGUAY

40543733

www.samsung.com

UZBEKISTAN

8-10-800-500-55-500

www.samsung.com

VENEZUELA

0-800-100-5303

www.samsung.com

8-10-800-500-55-500

www.samsung.com

VIETNAM

1 800 588 889

www.samsung.com

0800-329-999

www.samsung.com

ZAMBIA

211350370

www.samsung.com

0266-026-066
0685 88 99 00

www.samsung.com

1800-29-3232

www.samsung.com/th

02-689-3232

TRINIDAD &
TOBAGO

1-800-SAMSUNG (726-7864)

www.samsung.com

TURKEY

444 77 11

www.samsung.com

U.A.E

800-SAMSUNG (726-7864)

www.samsung.com

U.K

0330 SAMSUNG (726-7864)

www.samsung.com
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ADF
The following glossary helps you get familiar with the product by
understanding the terminologies commonly used with printing as well as
mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN)
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE
802).

802.11b/g/n
802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150
Mbps. 802.11b/g/n devices may occasionally suffer interference from
microwave ovens, cordless telephones, and Bluetooth devices.

An Automatic Document Feeder (ADF) is a scanning unit that will automatically
feed an original sheet of paper so that the machine can scan some amount of the
paper at once.

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for
computer networking. It was included in the original Macintosh (1984) and is
now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to represent the
color of a single pixel in a bitmapped image. Higher color depth gives a broader
range of distinct colors. As the number of bits increases, the number of possible
colors becomes impractically large for a color map. 1-bit color is commonly
called as monochrome or black and white.

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that connects
wireless communication devices together on wireless local area networks
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals.

BMP
A bitmapped graphics format used internally by the Microsoft Windows
graphics subsystem (GDI), and used commonly as a simple graphics file format
on that platform.
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BOOTP

Coverage

Bootstrap Protocol. A network protocol used by a network client to obtain its IP
address automatically. This is usually done in the bootstrap process of
computers or operating systems running on them. The BOOTP servers assign
the IP address from a pool of addresses to each client. BOOTP enables 'diskless
workstation' computers to obtain an IP address prior to loading any advanced
operating system.

It is the printing term used for a toner usage measurement on printing. For
example, 5% coverage means that an A4 sided paper has about 5% image or text
on it. So, if the paper or original has complicated images or lots of text on it, the
coverage will be higher and at the same time, a toner usage will be as much as
the coverage.

CSV
CCD
Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD
Locking mechanism is also used to hold the CCD module to prevent any damage
when you move the machine.

Comma Separated Values (CSV). A type of file format, CSV is used to exchange
data between disparate applications. The file format, as it is used in Microsoft
Excel, has become a de facto standard throughout the industry, even among
non-Microsoft platforms.

Collation

DADF

Collation is a process of printing a multiple-copy job in sets. When collation is
selected, the device prints an entire set before printing additional copies.

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will
automatically feed and turn over an original sheet of paper so that the machine
can scan on both sides of the paper.

Control Panel
Default
A control panel is a flat, typically vertical, area where control or monitoring
instruments are displayed. They are typically found in front of the machine.

The value or setting that is in effect when taking a printer out of its box state,
reset, or initialized.
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DHCP

DPI

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking
protocol. A DHCP server provides configuration parameters specific to the DHCP
client host requesting, generally, information required by the client host to
participate on an IP network. DHCP also provides a mechanism for allocation of
IP addresses to client hosts.

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and
printing. Generally, higher DPI results in a higher resolution, more visible detail
in the image, and a larger file size.

DIMM

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company
service which enables a user to use a single telephone line to answer several
different telephone numbers.

Dual Inline Memory Module (DIMM), a small circuit board that holds memory.
DIMM stores all the data within the machine like printing data, received fax data.

DRPD

Duplex
DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows devices on
a home network to share information with each other across the network.

A mechanism that will automatically turn over a sheet of paper so that the
machine can print (or scan) on both sides of the paper. A printer equipped with
a Duplex Unit can print on both sides of paper during one print cycle.

DNS

Duty Cycle

The Domain Name Server (DNS) is a system that stores information associated
with domain names in a distributed database on networks, such as the Internet.

Duty cycle is the page quantity which does not affect printer performance for a
month. Generally the printer has the lifespan limitation such as pages per year.
The lifespan means the average capacity of print-outs, usually within the
warranty period. For example, if the duty cycle is 48,000 pages per month
assuming 20 working days, a printer limits 2,400 pages a day.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head that
runs back and forth on the page and prints by impact, striking an ink-soaked
cloth ribbon against the paper, much like a typewriter.
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ECM

EtherTalk

Error Correction Mode (ECM) is an optional transmission mode built into Class 1
fax machines or fax modems. It automatically detects and corrects errors in the
fax transmission process that are sometimes caused by telephone line noise.

A suite of protocols developed by Apple Computer for computer networking. It
was included in the original Macintosh (1984) and is now deprecated by Apple
in favor of TCP/IP networking.

Emulation

FDI

Emulation is a technique of one machine obtaining the same results as another.

Foreign Device Interface (FDI) is a card installed inside the machine to allow a
third party device such as a coin operated device or a card reader. Those devices
allow the pay-for-print service on your machine.

An emulator duplicates the functions of one system with a different system, so
that the second system behaves like the first system. Emulation focuses on exact
reproduction of external behavior, which is in contrast to simulation, which
concerns an abstract model of the system being simulated, often considering its
internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local area
networks (LANs). It defines wiring and signaling for the physical layer, and frame
formats and protocols for the media access control (MAC)/data link layer of the
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most
widespread LAN technology in use during the 1990s to the present.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files
over any network that supports the TCP/IP protocol (such as the Internet or an
intranet).

Fuser Unit
The part of a laser printer that fuses the toner onto the print media. It consists of
a heat roller and a pressure roller. After toner is transferred onto the paper, the
fuser unit applies heat and pressure to ensure that the toner stays on the paper
permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

IEEE

A connection between computer networks, or between a computer network
and a telephone line. It is very popular, as it is a computer or a network that
allows access to another computer or network.

The Institute of Electrical and Electronics Engineers (IEEE) is an international
non-profit, professional organization for the advancement of technology
related to electricity.

Grayscale

IEEE 1284

A shades of gray that represent light and dark portions of an image when color
images are converted to grayscale; colors are represented by various shades of
gray.

The 1284 parallel port standard was developed by the Institute of Electrical and
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector
type on the end of the parallel cable that attaches to the peripheral (for example,
a printer).

Halftone
Intranet
An image type that simulates grayscale by varying the number of dots. Highly
colored areas consist of a large number of dots, while lighter areas consist of a
smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard disk, is a
non-volatile storage device which stores digitally-encoded data on rapidly
rotating platters with magnetic surfaces.

A private network that uses Internet Protocols, network connectivity, and
possibly the public telecommunication system to securely share part of an
organization's information or operations with its employees. Sometimes the
term refers only to the most visible service, the internal website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in order to
identify and communicate with each other on a network utilizing the Internet
Protocol standard.
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IPM

ITU-T

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM
rate indicates the number of single-sided sheets a printer can complete within
one minute.

The International Telecommunication Union is an international organization
established to standardize and regulate international radio and
telecommunications. Its main tasks include standardization, allocation of the
radio spectrum, and organizing interconnection arrangements between
different countries to allow international phone calls. A -T out of ITU-T indicates
telecommunication.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for printing as
well as managing print jobs, media size, resolution, and so forth. IPP can be used
locally or over the Internet to hundreds of printers, and also supports access
control, authentication, and encryption, making it a much more capable and
secure printing solution than older ones.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile
transmissions.

IPX/SPX

JBIG

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a
networking protocol used by the Novell NetWare operating systems. IPX and
SPX both provide connection services similar to TCP/IP, with the IPX protocol
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was
primarily designed for local area networks (LANs), and is a very efficient protocol
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with
no loss of accuracy or quality, which was designed for compression of binary
images, particularly for faxes, but can also be used on other images.

ISO

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used standard
method of lossy compression for photographic images. It is the format used for
storing and transmitting photographs on the World Wide Web.

The International Organization for Standardization (ISO) is an international
standard-setting body composed of representatives from national standards
bodies. It produces world-wide industrial and commercial standards.
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LDAP

MH

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for
querying and modifying directory services running over TCP/IP.

Modified Huffman (MH) is a compression method for decreasing the amount of
data that needs to be transmitted between the fax machines to transfer the
image recommended by ITU-T T.4. MH is a codebook-based run-length
encoding scheme optimized to efficiently compress white space. As most faxes
consist mostly of white space, this minimizes the transmission time of most
faxes.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates the status
of a machine.

MMR
MAC address
Media Access Control (MAC) address is a unique identifier associated with a
network adapter. MAC address is a unique 48-bit identifier usually written as 12
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer,
and used as an aid for routers trying to locate machines on large networks.

Modified Modified READ (MMR) is a compression method recommended by ITUT T.6.

Modem
A device that modulates a carrier signal to encode digital information, and also
demodulates such a carrier signal to decode transmitted information.

MFP
MR
Multi Function Peripheral (MFP) is an office machine that includes the following
functionality in one physical body, so as to have a printer, a copier, a fax, a
scanner and etc.

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR
encodes the first scanned line using MH. The next line is compared to the first,
the differences determined, and then the differences are encoded and
transmitted.

Glossary

191

Glossary
NetWare

OSI

A network operating system developed by Novell, Inc. It initially used
cooperative multitasking to run various services on a PC, and the network
protocols were based on the archetypal Xerox XNS stack. Today NetWare
supports TCP/IP as well as IPX/SPX.

Open Systems Interconnection (OSI) is a model developed by the International
Organization for Standardization (ISO) for communications. OSI offers a
standard, modular approach to network design that divides the required set of
complex functions into manageable, self-contained, functional layers. The layers
are, from top to bottom, Application, Presentation, Session, Transport, Network,
Data Link and Physical.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for
print using a laser beam emitted from a laser printer, and it is usually green or
rust colored and has a cylinder shape.
An imaging unit containing a drum slowly wears the drum surface by its usage
in the printer, and it should be replaced appropriately since it gets worn from
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals
The first example of something, such as a document, photograph or text, etc,
which is copied, reproduced or translated to produce others, but which is not
itself copied or derived from something else.

PABX
A private automatic branch exchange (PABX) is an automatic telephone
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language (PDL)
developed by HP as a printer protocol and has become an industry standard.
Originally developed for early inkjet printers, PCL has been released in varying
levels for thermal, dot matrix printer, and laser printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed by
Adobe Systems for representing two dimensional documents in a device
independent and resolution independent format.
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PostScript

Protocol

PostScript (PS) is a page description language and programming language used
primarily in the electronic and desktop publishing areas. - that is run in an
interpreter to generate an image.

A convention or standard that controls or enables the connection,
communication, and data transfer between two computing endpoints.

PS
Printer Driver
See PostScript.
A program used to send commands and transfer data from the computer to the
printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can be used
in a printer, a scanner, a fax or, a copier.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the world's
public circuit-switched telephone networks which, on industrial premises, is
usually routed through the switchboard.

RADIUS
PPM
Pages Per Minute (PPM) is a method of measurement for determining how fast
a printer works, meaning the number of pages a printer can produce in one
minute.

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote
user authentication and accounting. RADIUS enables centralized management
of authentication data such as usernames and passwords using an AAA
(authentication, authorization, and accounting) concept to manage network
access.

PRN file
Resolution
An interface for a device driver, this allows software to interact with the device
driver using standard input/output system calls, which simplifies many tasks.

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi,
the greater the resolution.
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SMB

TCP/IP

Server Message Block (SMB) is a network protocol mainly applied to share files,
printers, serial ports, and miscellaneous communications between nodes on a
network. It also provides an authenticated Inter-process communication
mechanism.

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of
communications protocols that implement the protocol stack on which the
Internet and most commercial networks run.

TCR
SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions
across the Internet. SMTP is a relatively simple, text-based protocol, where one
or more recipients of a message are specified, and then the message text is
transferred. It is a client-server protocol, where the client transmits an email
message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All
wireless devices in a WLAN use the same SSID in order to communicate with
each other. The SSIDs are case-sensitive and have a maximum length of 32
characters.

Transmission Confirmation Report (TCR) provides details of each transmission
such as job status, transmission result and number of pages sent. This report can
be set to print after each job or only after failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped image
format. TIFF describes image data that typically come from scanners. TIFF
images make use of tags, keywords defining the characteristics of the image that
is included in the file. This flexible and platform-independent format can be
used for pictures that have been made by various image processing
applications.

Toner Cartridge
Subnet Mask
The subnet mask is used in conjunction with the network address to determine
which part of the address is the network address and which part is the host
address.

A kind of bottle or container used in a machine like a printer which contains
toner. Toner is a powder used in laser printers and photocopiers, which forms
the text and images on the printed paper. Toner can be fused by by a
combination of heat/pressure from the fuser, causing it to bind to the fibers in
the paper.
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TWAIN

Watermark

An industry standard for scanners and software. By using a TWAIN-compliant
scanner with a TWAIN-compliant program, a scan can be initiated from within
the program. It is an image capture API for Microsoft Windows and Apple
Macintosh operating systems.

A watermark is a recognizable image or pattern in paper that appears lighter
when viewed by transmitted light. Watermarks were first introduced in Bologna,
Italy in 1282; they have been used by papermakers to identify their product, and
also on postage stamps, currency, and other government documents to
discourage counterfeiting.

UNC Path
WEP
Uniform Naming Convention (UNC) is a standard way to access network shares
in Window NT and other Microsoft products. The format of a UNC path is:
\\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents and
resources on the Internet. The first part of the address indicates what protocol to
use, the second part specifies the IP address or the domain name where the
resource is located.

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to
provide the same level of security as that of a wired LAN. WEP provides security
by encrypting data over radio so that it is protected as it is transmitted from one
end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is originally
introduced in Windows Me and Windows XP. A scan can be initiated from within
these operating systems by using a WIA-compliant scanner.

USB
WPA
Universal Serial Bus (USB) is a standard that was developed by the USB
Implementers Forum, Inc., to connect computers and peripherals. Unlike the
parallel port, USB is designed to concurrently connect a single computer USB
port to multiple peripherals.

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi)
computer networks, which was created to improve upon the security features of
WEP.
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WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or
home users. A shared key, or password, is configured in the wireless access point
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique
key for each session between a wireless client and the associated WAP for more
advanced security.

WPS
The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home
network. If your wireless access point supports WPS, you can configure the
wireless network connection easily without a computer.

XPS
XML Paper Specification (XPS) is a specification for a Page Description Language
(PDL) and a new document format, which has benefits for portable document
and electronic document, developed by Microsoft. It is an XML-based
specification, based on a new print path and a vector-based deviceindependent document format.
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